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CRINNO – EMERIC I



∆Ε∆ΟΜΕΝΑ (ΣΤΟΙΧΕΙΑ)

Σύστηµα Γεωγραφικών
Πληροφοριών

Σύστηµα

Σύστηµα Πληροφοριών

Γεγονότα
Φαινόµενα
Αντικείµενα
Γνωστά µεγέθη

Πληροφορία

Επεξεργασία
Ανάλυση

Ένα οργανωµένο σύνολο επιµέρους τµηµάτων που συνδέονται
λειτουργικά µεταξύ τους για κάποιο σκοπό
Κριτήρια ταξινόµησης

♦Φυσικά – τεχνητά
♦Αφηρηµένα – συγκεκριµένα

♦Στατικά – δυναµικά
♦Απλά - σύνθετα

Μία διαχειριστική διαδικασία, η οποία µετατρέπει τα στοιχεία σε
πληροφορίες για λήψη αποφάσεων

Ένα σύστηµα πληροφοριών µε χωρικά προσδιορισµένη βάση
δεδοµένων

ΓΕΩΓΡΑΦΙΚΑ ΣΥΣΤΗΜΑΤΑ ΠΛΗΡΟΦΟΡΙΩΝ
∆ιερεύνηση
Μετατροπή κλίµακας
Μέτρηση εµβαδών
Στατιστική ανάλυση/τάσεις
Υπέρθεση επιπέδων
Προσοµείωση/µοντελοποίηση
∆ιαχείριση πληροφοριών
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Ορισμός των Γεωγραφικών Συστημάτων Πληροφοριών (GIS)

Σύνθεση πολλών επιστημονικών κλάδων.

Ουσιαστικό εργαλείο για την διαχείριση και τον σχεδιασμό των αστικών περιοχών και την
διαχείριση των φυσικών πόρων

Επέκταση σε εφαρμογές διαχείρισης χρήσεων γής, μοντελοποίηση οικοσυστημάτων, 
σχεδιασμό επικοινωνιακών συστημάτων και μεταφορών, ανάλυση εμπορικών σχέσεων, 
προσαρμογή συντελεστών δόμησης και φορολογικών μέτρων, προστασίας περιβάλλοντος, 
ανάλυσης ορατότητας, κ.α.

Λειτουργίες του GIS
Αποθήκευση, ανάκτηση, ανάλυση, μοντελοποίηση και χαρτογράφηση

Εφαρμογές του GIS
•Χαρτογράφηση θέσεων
•Χαρτογράφηση ποσοτήτων
•Χαρτογράφηση ποσοστών και πυκνοτήτων
•Υπολογισμό Αποστάσεων
•Χαρτογράφηση και παρακολούθηση των χρονικών αλλαγών στον χώρο

προγνωστικά συστήματα
Μοντελοποίηση
Λήψη αποφάσεων
Έλεγχος συστημάτων
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Ειδη Συστηµάτων
Πληροφοριών
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∆ιαδικασίες
Γεωγραφικών
Συστηµάτων
Πληροφοριών
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Τύποι ∆εδοµένων
Γεωγραφικών
Συστηµάτων
Πληροφοριών
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Επικοινωνιακή Πολιτική & Χαρτογραφικά Δεδομένα
H Σημασία των Χαρτών
Τοποθεσία
Χωρικά χαρακτηριστικά/πληροφορίες
Χρήση απο ευρύ φάσμα επιστημών.

Οι χάρτες ως συμβολικές γενικεύσεις της
πραγματικότητας
1.Πόσο γενικευμένη και απλουστευμένη είναι η
αποτύπωση;
2.Πως συμβολίζονται οι γενικεύσεις και οι σχέσεις
μεταξύ παραμέτρων;

Ποιότητα χαρτών
Ένας καλός χάρτης είναι ένας χάρτης που επικοινωνεί καλύτερα με τους αποδέκτες των πληροφοριών
Σκοπός
Διαθέσιμα δεδομένα
Τελικός αποδέκτης
Χρήση
Τρόπος παρουσίασης
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Στοιχεία Σύνταξης Χαρτών

Είδος και τύπος του τελικού προϊόντος
Τί είδους πληροφορίες θα αποτυπωθούν
και µε τι ακρίβεια;

Γενίκευση & απλούστευση
Σχέση µε την κλίµακα

Στοιχεία ανάγνωσης χαρτών

Απαραίτητα στοιχεία: Κλίµακα, 
διεύθυνση βορρά, συµβολισµός, πηγές
πληροφόρησης

Στοιχεία ως προς το θέµα: Τίτλος, 
προβολικό σύστηµα, ηµεροµηνία
σύνταξης, φορέας.

Βοηθητικά στοιχεία: θέση χάρτη, 
ιστογράµµατα, µεγάλης κλίµακας χάρτες.
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H Σηµειωτική της Χαρτογραφίας

Χρώµα & Συµβολισµός
Συµβολισµός για την τοποθεσία, διεύθυνση, απόσταση, µετακίνηση, λειτουργία, συσχέτιση, διαδικασία, ποσότητα, 

κ.α.
Χρώµα, σηµεία, γραµµές, πολύγωνα.

Κατηγορίες µε βάση το µέγεθος, σχήµα, τιµή, διεύθυνση, απόχρωση, κ.α.

4 επίπεδα µετρήσεων για την περιγραφή των φυσικών µεγεθών
• Ονοµαστικά δεδοµένα (Nominal data) – πληροφορίες που κατηγοριοποιούνται µε βάση τα ποιοτικά

χαρακτηριστικά τους (είδος αντικειµένου, όνοµα, κ.α.)

• Ποσοτικά δεδοµένα (Ordinal data) – κατηγοροποίηση µε βάση τα ποσοτικά τους χαρακτηριστικά: µικρό, 
µεγάλο, µεσαίο, µονό, διπλό, τριπλό, κ.α. (π.χ. κύριο, δευτερεύων, αγροτικός δρόµος, κ.α.)

• ∆εδοµένα διαστηµάτων (Interval data) – πληροφορίες που κατανέµονται χρησιµοποιώντας µία
συγκεκριµένη κλίµακα (προσθετική ή αφαιρετική).  Πχ. Μέτρηση της θερµοκρασίας.

• Αναλογικά (αριθµητικά) δεδοµένα (Ratio data) – όπως τα δεδοµένα διαστηµάτων, αλλά η κλίµακα
µέτρησης ξεκινάει απο ένα τυχαίο σηµείο. Πχ. Υψόµετρο απο την θάλασσα, πυκνότητα πληθυσµού, ποσοστό
βροχόπτωσης.
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ΣτατιστικήΣτατιστική ΓενίκευσηΓενίκευση ΧαρτώνΧαρτών
ΧαρτογράφησηΧαρτογράφηση στατιστικώνστατιστικών στοιχείωνστοιχείων µεµε στόχοστόχο τηντην αποτύπωσηαποτύπωση χωρικώνχωρικών τάσεωντάσεων καικαι κατανοµώνκατανοµών
∆ιαφοροποίηση∆ιαφοροποίηση µεµε βάσηβάση τοντον αριθµόαριθµό τωντων κατηγοριώνκατηγοριών καικαι τατα όριαόρια καθορισµούκαθορισµού τωντων τάξεωντάξεων

ΜέθοδοιΜέθοδοι κατανοµήςκατανοµής//κατηγοροποίησηςκατηγοροποίησης µετρήσεωνµετρήσεων
ΣηµείοΣηµείο αποκοπήςαποκοπής ((σηµείοσηµείο διαχωρισµούδιαχωρισµού µεταξύµεταξύ δύοδύο κατηγοριώνκατηγοριών).  ).  ΠροσδιορισµόςΠροσδιορισµός

ΤαξινόµησηΤαξινόµηση
--ΕΕxhaustivexhaustive ((όλεςόλες οιοι µετρήσειςµετρήσεις σεσε έναένα εύροςεύρος εµπίπτουνεµπίπτουν σεσε µίαµία κατηγορίακατηγορία –– καµίακαµία τιµήτιµή µέσαµέσα σεσε αυτόαυτό
τοτο εύροςεύρος δενδεν αποκλείεταιαποκλείεται εκτόςεκτός τηςτης ταξινόµησηςταξινόµησης))
--Mutually exclusiveMutually exclusive ((κάθεκάθε τιµήτιµή τοποθετείταιτοποθετείται σεσε µίαµία καικαι µόνοµόνο µίαµία κατηγορίακατηγορία –– δενδεν υπάρχειυπάρχει επικάλυψηεπικάλυψη
µεταξύµεταξύ τωντων κατηγοριώνκατηγοριών))

Κατηγορίες ίσου εύρους
=(Xmax – Xmin) / Number of intervals
π.χ.  Μετρήσεις απο το 16 – 25, µπορούν να

ταξινοµηθούν σε 5 κατηγορίες εύρους 2 
µονάδων

Για «τετράγωνες» (ισοµεγέθεις) κατανοµές.

Κατηγορίες ίσου εύρους
• ∆ηµιουργία κατηγοριών µε ίδιο αριθµό µετρήσεων σε

κάθε κατηγορία.  
• Π.χ. εάν έχουµε ένα σύνολο 100 µετρήσεων και

θέλουµε να δηµιουργήσουµε 5 κατηγορίες, οι
µικρότερες 20 µετρήσεις θα ταξινοµηθούν σε µία τάξη, 
οι 20 µεγαλύτερες σε άλλη, κ.λ.π.

• 4 κατηγορίες - quartiles 
• 5 κατηγορίες – quintiles
• 6 κατηγορίες - sextiles
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ΓΕΩΓΡΑΦΙΚΑ ∆Ε∆ΟΜΕΝΑ

Χώρος Χρόνος

Παρατήρηση/µέτρηση Ιδιότητα/µεταβλητή

Χωρική συνιστώσα
Απόλυτη χωροθέτηση (x,y,z)
Tοπολογική συσχέτιση

Θεµατική συνιστώσα
Θεµατικό αντικείµενο (στατιστική)
Χωρικό αντικείµενο (χωρική ανάλυση)

Αεροφωτογραφίες

Δορυφορικές εικόνες

Μετρήσεις GPS ή ΕDM

Βάσεις δεδομένων

Ψηφιοποιημένα δεδομένα (ψηφιοποιητή ή σαρωτή)

Δεδομένα GIS
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ΑΠΕΙΚΟΝΙΣΗ ΧΑΡΤΟΓΡΑΦΙΚΗΣ ∆ΙΑ∆ΙΚΑΣΙΑΣ
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Γεωγραφικά δεδοµένα
Σχέσεις

δεδοµένωνΙδιότητες δεδοµένων & 
χαρακτηριστικά

Μοντελοποίηση
- Ανάλυση

Μοντέλα δεδοµένων
♦Για την οργάνωση – απεικόνιση
πληροφοριών
♦Για την µετατροπή σε
µεταφράσιµα απο Η/Υ
χαρακτηριστικά

Mοντέλο Λογικών
Πληροφοριών
(Datalogical)

Μοντέλο Λογικών
Πληροφοριών
(Ιnfological)

Aνθρώπινη
αντίληψη & 
απεικόνιση της
πραγµατικότητας

Λειτουργία Η/Υ, 
αποθήκευση
δεδοµένων, οργάνωση.

Σχέση : σύνδεση µεταξύ αντικειµένων

1:1 (αντιστοιχία ενός µε ένα και µοναδικό)

1:m (ένα προς πολλά)
n:m (πολλά προς πολλά)

Χωρικές σχέσεις
Τοπολογικές (ιδιότητες

γειτνίασης/συνεκτικότητας)

Προσεγγιστικές (ιδιότητες
προσέγγισης των µή
γειτονικών αντικειµένων)

Ιεραρχικές (πιο περιέχει ή
περιέχεται σε κάποιο άλλο
αντικείµενο)

Κατηγορικές σχέσεις
Ιδιότητες

ταξινόµησης, 
αρχειοθέτησης

ΜΟΝΤΕΛΑ ΓΕΩΓΡΑΦΙΚΩΝ ∆Ε∆ΟΜΕΝΩΝ

Οργάνωση
Τυποποίηση

Κωδικοποίηση
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∆ιανυσµατικά ∆εδοµένα

Γραµµές ή τόξα ως βασική λογική µονάδα (µε αρχή και τέλος σε σηµεία nodes)

Τοπολογία
Τα γεωγραφικά διανυσµατικά δεδοµένα έχουν συγκεκριµένη τοπολογία (χωρικά χαρακτηριστικά), 
ενώ τα θεµατικά χαρακτηριστικά τους σχετίζονται µε την τοπολογία αυτή.  Η σύνδεση αυτή γίνεται
µε µία σχεσιακή βάση δεδοµένων η οποία αναγνωρίζει τα διαφορετικά αντικείµενα µε ένα κωδικό
αναγνώρισης, που είναι µοναδικός και διαφορετικός για κάθε αντικείµενο.

∆ιανυσµατική αναπαράσταση
Συντεταγµένες: ένα ζεύγος σηµείων που απεικονίζει τις αποστάσεις σε ένα ορθογώνιο σύστηµα
συντεταγµένων. (τρείς συντεταγµένες για 3D χώρο, ν-συντεταγµένες για ν διαστάσεις)

Σηµεία: Mηδενική διάσταση.  Συντεταγµενες x,y.  Πιθανώς και z.  

Γραµµές: Μονοδιάστατα αντικείµενα (π.χ. ισουψείς, δρόµοι, ποτάµια).  Αναπαριστάνεται µε µία
σειρά σηµείων.  Στο ARC/INFO µία γραµµή ονοµάζεται και «arc».
Π.χ.  ∆ίκτυα που αποτελούνται από σύνδεσµους (links) που ενώνονται από κόµβους (nodes).  

Tα links παίρνουν την µορφή γραµµών όπου το κάθε τµήµα τους (segment) έχει αρχικές και τελικές
συντεταγµένες.
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ΨΗΦΙ∆ΩΤΑ ΜΟΝΤΕΛΑ

•∆ιαίρεση της περιοχής σε µία σειρά
χωρικών ενοτήτων, µε συγκεκριµένες
ιδιότητες
•∆υνατότητα απεριόριστης επέκτασης στον
χώρο
•Συνατότητα συνεχούς και
επαναλαµβανόµενης υποδιαίρεσης (ίδιου
σχήµατος)

Κανονικής µορφής (τετράγωνο, 
ισόπλευρο τρίγωνο, κ.α.)
πολυφασµατικοί σαρωτές – δορυφορικοί
δέκτες
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Εισαγωγή χωρικών δεδοµένων και πληροφοριών στο GIS

•Ψηφιοποίηση και σάρωση αναλογικών χαρτών

•Σάρωση αναλογικών εικόνων (π.χ. αεροφωτογραφιών)

•Εισαγωγή τοπογραφικών µετρήσεων (π.χ. GPS)

•Mεταφορά ψηφιακών δεδοµένων

•Χάρτες – κλίµακα-ανάλυση-ακρίβεια

•Βάσεις δεδοµένων
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ΨηφιοποίησηΨηφιοποίηση ΧαρτογραφικούΧαρτογραφικού ΥλικούΥλικού
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ΤοπογραφικέςΤοπογραφικές ΑποτυπώσειςΑποτυπώσεις
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Γεωγραφικές Συντεταγµένες στο ελλειψοειδές

φ
λ

ισηµερινός

Μεσηµβρινός του
Greenwich

Μεσηµβρινός στο Α

Α

Καρτεσιανό σύστηµα συντεταγµένων
Χ, Υ ή Ε (east), N (North) σε m (µέτρα)
Η διεύθυνση του Βορρά ταυτίζεται µε την
διεύθυνση του µεσηµβρινού.

Το πρόβληµα εστιάζεται στην αποτύπωση του
ελλειψοειδούς σε ένα επίπεδο (χάρτη).  

Το ελλειψοειδές είναι µία µή-αναπτυκτή
επιφάνεια και για τον λόγο αυτό υπάρχει
παραµόρφωση των σχηµάτων του ελλειψοειδούς
στην επιφάνεια.  

Τα προβολικά συστήµατα παρέχουν λεπτοµέρειες
απεικόνισης και παραµόρφωσης των µεγεθών

To ελλειψοειδές χρησιµοποιείται καλύτερα ως
επιφάνεια αναφοράς για τις οριζόντιες
συντεταγµένες (φ, λ).

Το γεωειδές χρησιµοποιείται καλύτερα ως
επιφάνεια αναφοράς για τα υψόµετρα

ΕΓΣΑ’87 ή GREEK DATUM
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ΨΗΦΙΑΚΟ ΜΟΝΤΕΛΟ ΕΔΑΦΟΥΣ

Η ψηφιακή περιγραφή της επιφάνειας, η οποία βασίζεται σε
μετρήσεις σημείων της και συνοδεύεται απο ένα σύνολο
κανόνων, που επιτρέπουν να εξαχθεί μία πληροφορία

Ένα ψηφιακό μοντέλο εδάφους αποτελείται από
•Έναν κατάλογο συντεταγμένων Χ, Υ, Ζ.
•Ένα σύνολο καταλλήλων κανόνων παρεμβολής.  Π.χ.  να
βρεθεί το Ζ για ένα οποιοδήποτε άλλο ζεύγος Χ, Υ.

Για τρισδιάστατες συντεταγμένες σημείων: 
Ψηφιακό Μοντέλο εδάφους (Digital Terrain Model, DTM) ή
Ψηφιακό Μοντέλο Αναγλύφου (Digital Elevation Model, DEM).
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Τοπογραφικά ∆εδοµένα (Υψοµετρική πληροφορία)
Ισο-υψείς καµπύλες (ένωση σηµείων µε το ίδιο υψόµετρο) επιφάνεια

Μοντέλα επιφανειών
Τα µοντέλα επιφανειών δηµιουργούνται συνήθως απο ένα µοντέλο TIN ή ένα µοντέλο πλέγµατος (lattice).

Ένα µοντέλο TIN (Triangular Irregular Network) αποτελείται από ένα συνεχές πλέγµα τριγώνων, τα
οποία διαφοροποιούνται ως προς το µέγεθός τους ανάλογα µε την ακρίβεια αποτύπωσης της τραχύτητας της
επιφανείας.

Μεγάλα τρίγωνα για σχετικά επίπεδες ή οµαλά κεκλιµένες επιφάνειες και µικρά τρίγωνα για επιφάνειες
µεταβλητής κλίσης.  Η κλίση, ο προσανατολισµός και διεύθυνση ροής µπορούν άµεσα να υπολογιστούν απο
ένα µοντέλο ΤΙΝ.

Τα µοντέλα πλέγµατος (DEM – DTM) είναι όµοια µε τα ψηφιδωτά µοντέλα, όπου το υψόµετρο
απεικονίζεται σε κάθε ένα pixel.  Με τον τρόπο αυτό, γίνεται εύκολος υπολογισµός της κλίσης, του
προσανατολισµού, της διεύθυνσης της ροής, της ορατότητας, κ.α.

Εργαστήριο Γεωφυσικής – ∆ορυφορικής Τηλεπισκόπησης & Αρχαιοπεριβάλλοντος
Ινστιτούτο Μεσογειακών Σπουδών (I.M.Σ.) - Ίδρυµα τεχνολογίας & Έρευνας (I.T.E.)



Χρήσεις & Προϊόντα του Ψηφιακού Μοντέλου Εδάφους

Υπολογισµός ιδιοτήτων της επιφανείας του εδάφους (υψόµετρο σε κάθε
σηµείο, κλίση, προσανατολισµός, φωτοσκίαση, κ.α.

Εντοπισµός στοιχείων όπως οι λεκάνες απορροής, κορυφογραµµές, δίκτυα
επικοινωνιών και υδροδότησης, δίκτυα ορατότητας, κ.α. 

Μοντελοποίηση υδρολογικών λειτουργιών, ενεργειακή ροή, δασικές
πυρκαγιές, µετακίνηση πληθυσµού, κ.α.

DEM Kλίση σε ο ή % Φωτοσκίαση Προσανατολισµός Ορατότητα
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Buffers (Ζώνες Επέκτασης)

∆ηµιουργία Ζωνών επέκτασης
συγκεκριµένου εύρους γύρω
απο ένα σηµείο, γραµµή ή
πολύγωνο.  

Η διαδικασία αυτή δηµιουργεί
ένα πολύγωνο συγκεκριµένου
πλάτους, το οποίο µπορεί να
χρησιµοποιηθεί σε
αναζητήσεις για να
προσδιοριστούν ποιές
οντότητες βρίσκονται στο
εσωτερικό ή εκτός µιας
περιοχής που ορίζεται απο το
πολύγωνο του buffer.  

Αποτελεί το διανυσµατικό
αντίστοιχο της ανάλυσης της
απόστασης στα Γεωγραφικά
Συστήµατα Πληροφοριών.
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Υπέρθεση

Η Υπέρθεση δηµιουργεί νέα στοιχεία και σχέσεις ιδιοτήτων µέσω της
υπέρθεσης των στοιχείων δύο χαρτογραφικών υποβάθρων.  

Τα στοιχεία από τον ένα χάρτη συνδέονται µε τα στοιχεία του άλλου
χάρτη, δηµιουργώντας νέα στοιχεία µε συνδυασµό των αρχικών
ιδιοτήτων. 

Οι χάρτες θεωρούνται ως πίνακες µεταβλητών τιµών, ενώ οι πράξεις
βασίζονται σε λογικές συνθήκες
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Παράδειγµα

Καταλληλότητα εδαφών προς
καλλιέργειες

Για την καλύτερη καλλιέργεια απαιτείται η
εξέταση των ιδιοτήτων των εδαφών (ΙΕ):  
υγρασία, οξυγόνο, συστατικά, ανθεκτικότητα
σε διάβρωση

Βάση αυτών των χαρακτηριστικών θέλουµε
να ταξινοµήσουµε τα εδάφη σε 3 
κατηγορίες:  Κατάλληλα, µέτρια και όχι
κατάλληλα για καλλιέργειες
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Data transfer from the Lab to Cyberspace
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ΓεωγραφικάΓεωγραφικά ΣυστήµαταΣυστήµατα
ΠληροφοριώνΠληροφοριών

G.I.S.G.I.S.
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CRINNO – EMERIC I
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ArcCatalog 
Εισαγωγή – Περιήγηση 

 
 

Το ArcCatalog αποτελεί το περιβάλλον στο οποίο εντοπίζετε, οργανώνετε και τεκµηριώνετε τα χωρικά σας 

δεδοµένα. 

Στις ακόλουθες ασκήσεις θα χρησιµοποιήσετε το ArcCatalog για την α) δηµιουργία, β) µετονοµασία, γ) 

διαγραφή θεµατικών ενοτήτων (shapefiles). 

 
 
 

I. Έναρξη του Προγράµµατος 
 
Για να ανοίξετε το ArcCatalog, πηγαίνετε στο κάτω-αριστερά µέρος της οθόνης σας και ακολουθήστε την 

διαδροµή  

Start -> Programs -> ArcGIS -> ArcCatalog  

 

 

 

II. Σύνδεση δεδοµένων µε το ArcCatalog 
 

Το γεωγραφικό σας υλικό είναι συγκεντρωµένο στον φάκελο GIS που βρίσκεται αποθηκευµένος στο 

C/seminars. Για να συνδέσετε τον φάκελο δεδοµένων µε τον Κατάλογο 

1) πηγαίνετε στην πρώτη µπάρα εργαλείων στο ανώτερο τµήµα του παραθύρου και κάντε κλικ στο 

κουµπί Connect to Folder.  

2) Το παράθυρο που θα εµφανιστεί σας επιτρέπει να πλοηγηθείτε στην τοποθεσία που βρίσκεται ο 

φάκελός σας και επιλέγοντάς τον να τον συνδέσετε. Πλοηγηθείτε στο C/seminars, 

3) Επιλέξτε τον φάκελο GIS  

4) Επιλέξτε OK για να συνδέσετε τον φάκελο.  
Ο φάκελος µε τα δεδοµένα σας θα παραµείνει συνδεδεµένος µε τον Κατάλογο µέχρι να τον αποσυνδέσετε οι ίδιοι.  

 

⇒ Αποσύνδεση δεδοµένων 

Αν επιθυµείτε να αποσυνδέσετε έναν φάκελο, κάνετε δεξί κλικ πάνω του και επιλέγετε την εντολή Disconnect Folder 

ή επιλέγετε µε αριστερό κλικ τον φάκελο και πατάτε το κουµπί Disconnect From Folder      από την πρώτη µπάρα 

εργαλείων στο ανώτερο τµήµα του παραθύρου. 
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ΙΙΙ. ∆ηµιουργία Φακέλου ∆εδοµένων στο ArcCatalog 

 

Μέσα στον φάκελο GIS που µόλις συνδέσατε µε τον Κατάλογο, θα δηµιουργήσετε έναν προσωπικό σας 

υποφάκελο. Θα τον ονοµάσετε results και στο εξής θα αποθηκεύετε εκεί τις εργασίες σας. 

 

1) Mε δεξί κλικ στον φάκελο GIS επιλέξτε New -> Folder  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2) Ο νέος φάκελος θα εµφανιστεί στο παράθυρο επισκόπησης του Καταλόγου σε κατάσταση 

συµπλήρωσης του ονόµατος που επιθυµείτε. Πληκτρολογήστε το όνοµα results. 

3) Πατήστε ENTER από το πληκτρολόγιο για να αποθηκεύσετε το νέο όνοµα. 

 

⇒ Μετονοµασία – διαγραφή δεδοµένων 

Αν επιθυµείτε να µετονοµάσετε ή να σβήσετε κάποιο από τα περιεχόµενα ενός φακέλου ή τον ίδιο τον φάκελο, το 

επιλέγετε µε δεξί κλικ και κατόπιν επιλέγετε τις εντολές Rename ή Delete αντίστοιχα. 
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ArcMap 

Εισαγωγή – Περιήγηση 
 

Το ArcMap αποτελεί το κατεξοχήν περιβάλλον εργασίας του ArcGIS. Στο ArcMap α) προβάλλετε και β) 

διορθώνετε δεδοµένα, γ) δηµιουργείτε χωρικά µοντέλα, και δ) συνθέτετε χάρτες.  

 
 
 

I. Έναρξη του Προγράµµατος 
 

Για να «ανοίξετε» µια νέα εργασία (Project) στο ArcMap, ακολουθήστε την διαδροµή 

Start -> Programs -> ArcGIS -> ArcMap 

 

II. Αποθήκευση εργασίας (Project) 
 

1) Από το µενού File, επιλέξτε Save As. 

2) Πλοηγηθείτε στον φάκελο results, που θυµίζουµε ότι βρίσκεται στο χώρο C/seminars/GIS 

και αποθηκεύστε εκεί την εργασία σας µε το όνοµα Project_1. 

3) Κατόπιν, από το µενού File, ακολουθήστε την διαδροµή 

   File -> Map Properties -> Data Source Options  

4) Επιλέξτε Store relative path names προκειµένου το σύστηµα να καταχωρεί στο εξής 

σχετικές διαδροµές για την εύρεση των αρχείων σας. 

 

⇒ Αποκατάσταση «χαµένου» αρχείου 

Στην περίπτωση που κατά τη διάρκεια των εργασιών σας 

χρειαστεί να µετακινήσετε σε άλλο φάκελο ένα αρχείο από 

αυτά που συνθέτουν την εργασία σας, όταν θα επανεκκινήσετε 

το ArcMap, το συγκεκριµένο αρχείο θα εµφανιστεί στον 

πίνακα περιεχοµένων µε ένα θαυµαστικό. Με αυτόν τον τρόπο 

το σύστηµα σας ειδοποιεί ότι δεν γνωρίζει πλέον από πού να 

ανακαλέσει το αρχείο αυτό. Σε αυτή την περίπτωση, από τον 

πίνακα περιεχοµένων κάνετε δεξί κλικ στο αρχείο και 

επιλέγετε την εντολή Properties.  

Σας εµφανίζεται ένα παράθυρο µε επιµέρους καρτέλες που 

συγκεντρώνουν πληροφορίες για το αρχείο αυτό. Επιλέξτε 

Source -> Set Data Source  και 

αναζητήστε τη νέα τοποθεσία καταχώρησης του αρχείου. 

Ολοκληρώστε µε ΟΚ. 
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ΙΙΙ. Εισαγωγή δεδοµένων στην επιφάνεια εργασίας του ArcMap 
 
Για να προσθέσετε δεδοµένα στην επιφάνεια εργασίας του ArcMap  

1) επιλέξτε το κουµπί Add Data      από τη µπάρα εργαλείων. 

2) Από το παράθυρο που θα σας εµφανιστεί πλοηγηθείτε στην τοποθεσία που βρίσκονται 

αποθηκευµένα τα δεδοµένα σας. 

3) Επιλέξτε το αρχείο που επιθυµείτε. 

4) Ολοκληρώστε την διαδικασία κάνοντας κλικ στο κουµπί Add. 

 
Αποδεχτείτε τις υπενθυµίσεις του συστήµατος που θα σας εµφανιστούν α) για την απουσία συστήµατος συντεταγµένων 

στο αρχείο, και σε περιπτώσεις raster αρχείων β) για τη δηµιουργία πυραµίδων. 

 

⇒ Οι πυραµίδες είναι χαµηλής ανάλυσης αναπαραστάσεις των raster δεδοµένων σας, που χρησιµοποιούνται στην 

βελτίωση της παρουσίασης τους. Οι πυραµίδες επιταχύνουν την εµφάνιση των rasters στην οθόνη µε το να 

ανακαλούν τα δεδοµένα µόνο στην ορισµένη ανάλυση που χρειάζεται για την εµφάνιση. Οι πυραµίδες 

δηµιουργούνται µετά από επαναδειγµατοληψία των πρωτότυπων αρχείων.  
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Γεωαναφορά (Georeferencing) 

 
Τα δεδοµένα που προέρχονται από σάρωση εικόνων, π.χ. χάρτες, σχέδια, αεροφωτογραφίες κτλ. (raster data) δεν 
εµπεριέχουν γεωγραφικές πληροφορίες. Προκειµένου να χρησιµοποιήσουµε δεδοµένα αυτής της µορφής για να 
ψηφιοποιήσουµε από αυτά δευτερεύοντα χωρικά δεδοµένα, είναι αναγκαίο να τα ευθυγραµµίσουµε ή αλλιώς να τα 
γεωαναφέρουµε µε βάση κάποιο χαρτογραφικό σύστηµα συντεταγµένων. 
 
Τα χαρτογραφικά συστήµατα συντεταγµένων ορίζονται µε τη χρήση χαρτογραφικών προβολών. Η χαρτογραφικές 
προβολές είναι µέθοδοι µε τις οποίες η κοίλη επιφάνεια της γης απεικονίζεται πάνω σε µια επίπεδη επιφάνεια. 
 
Κατά τη διαδικασία γεωαναφοράς raster δεδοµένων προσδιορίζουµε τη γεωγραφική τους θέση αποδίδοντάς τους 
πραγµατικές συντεταγµένες. Αυτό επιτυγχάνεται, γενικά, µε το να ταυτίσουµε τα δεδοµένα που χρειάζονται 
ευθυγράµµιση µε υπάρχοντα, ήδη ευθυγραµµισµένα (διορθωµένα) στο σύστηµα συντεταγµένων που µας ενδιαφέρει να 
χρησιµοποιήσουµε. Βασική προϋπόθεση είναι να εντοπίσουµε µια σειρά από διακριτά σηµεία (π.χ. γωνίες κτιρίων, 
διασταυρώσεις δρόµων κτλ.) που θα αποτελέσουν τους συνδέσµους για την ευθυγράµµιση. Με βάση αυτά τα σηµεία 
αναπτύσσουµε µια πολυωνυµική µετατροπή που θα µεταφέρει τα µη ευθυγραµµισµένα δεδοµένα από την υπάρχουσα 
θέση τους στην σωστή γεωγραφική τοποθεσία. 
 
Ο αριθµός των σηµείων-συνδέσµων που θα επικαλεστούµε εξαρτάται από την πολυπλοκότητα της πολυωνυµικής 
µετατροπής που σκοπεύουµε να χρησιµοποιήσουµε. Ωστόσο, ο µεγαλύτερος αριθµός σηµείων δεν εξασφαλίζει 
απαραίτητα και καλύτερη εγγραφή. Γενικά, η επιλογή τουλάχιστον ενός σηµείου κοντά σε κάθε γωνία της εικόνας και 
µερικών ακόµη διάσπαρτων οµοιόµορφα στο εσωτερικό της δίνουν συνήθως το καλύτερο αποτέλεσµα.  
 
Υπάρχουν διάφοροι τύποι πολυωνυµικής µετατροπής. Η πρώτη (First Order Polynomial ή Affine) εφαρµόζεται µε 
τουλάχιστον 3 σηµεία και είναι δυνατό να ταυτίσει επακριβώς κάθε σηµείο του «αδιόρθωτου» raster µε τα σηµεία του 
διορθωµένου. Η δεύτερη (Second Order Polynomial) εφαρµόζεται µε τουλάχιστον 6 σηµεία, ενώ η τρίτη (Third 
Order Polynomial) µε τουλάχιστον 10. Γενικά, όταν µας ενδιαφέρει απλά να «τεντώσουµε» την εικόνα 
χρησιµοποιούµε την πρώτη πολυωνυµική µετατροπή, ενώ στις περιπτώσεις που επιθυµούµε να κυρτώσουµε την εικόνα 
χρησιµοποιούµε την δεύτερη ή την τρίτη. Υψηλότερες πολυωνυµικές µετατροπές σπάνια χρησιµοποιούνται.  
 
Κατά την γεωαναφορά θα σκεφτόταν κανείς ότι κάθε κελί του αδιόρθωτου raster µεταφέρεται στην σωστή γεωγραφική 
του θέση. Στην ουσία όµως το σύστηµα δηµιουργεί ένα πλέγµα από κενά κελιά (cells) µε τη χρήση των γεωγραφικών 
συντεταγµένων και αποδίδει τιµές σε κάθε κενό κελί µε µια µέθοδο επαναδειγµατολειψίας. Οι τρεις συνηθέστερες 
µέθοδοι επαναδειγµατολειψίας είναι οι nearest neighbour assignment, bilinear interpolation, και cubic convolution. 
Οι µέθοδοι αυτές αποδίδουν τιµές στα κενά κελιά εξετάζοντας µε διαφορετικό τρόπο η καθεµιά τα κελιά της 
αδιόρθωτης εικόνας. Η µέθοδος nearest neighbour assignment αποδίδει τιµή στο κενό κελί µε βάση το πλησιέστερό 
του αδιόρθωτο. Είναι η ταχύτερη µέθοδος επαναδειγµατολειψίας και είναι κατάλληλη για categorical και thematic 
δεδοµένα. Οι bilinear interpolation και cubic convolution µέθοδοι λαµβάνουν υπόψη µεγαλύτερο αριθµό γειτονικών 
κελιών ( 4 και 16 αντίστοιχα) για να αποδώσουν ανάλογη τιµή στο κενό κελί. Οι µέθοδοι αυτές είναι κατάλληλες για 
continuous data, όπως επιφάνειες υψοµέτρου, κλίσης του εδάφους, αεροφωτογραφίες, κτλ. 
 
Μετά την ολοκλήρωση της γεωαναφοράς, είναι δυνατό να καταστήσουµε µόνιµη την µετατροπή αυτή δηµιουργώντας 
ένα νέο raster αρχείο από το αρχικό που είναι πλέον διορθωµένο. 
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Με τις ακόλουθες ασκήσεις θα γεωαναφέρετε δύο τοπογραφικούς χάρτες καταχωρώντας στο σύστηµα τις 
γεωγραφικές συντεταγµένες των άκρων του σύµφωνα µε το Ελληνικό Γεωδαιτικό Σύστηµα Αναφοράς 
(ΕΓΣΑ ’87) και στη συνέχεια θα διορθώσετε µια δορυφορική εικόνα επιλέγοντας σε αυτήν διακριτά σηµεία 
και ταυτίζοντάς τα µε τα αντίστοιχα σηµεία µίας ήδη διορθωµένης σε ΕΓΣΑ δορυφορικής εικόνας. 
 
Για να προσθέσετε στην επιφάνεια εργασίας την εργαλειοθήκη Γεωαναφοράς ακολουθήστε την διαδροµή 

View -> Toolbars -> Georeferencing.  

 
 

 

Ι. Με τον ακόλουθο τρόπο θα αποδώσετε συντεταγµένες σε ΕΓΣΑ ’87 στον τοπογραφικό χάρτη 9519_5 του 

Ηρακλείου που υπάρχει αποθηκευµένος στον φάκελο Georeferencing . 

1) Από το κουµπί Add     προσθέστε στην οθόνη σας τον τοπογραφικό χάρτη και βεβαιωθείτε ότι το 

όνοµά του αναγράφεται δίπλα από τη λέξη Layer: στο Georeferencing µενού  

2) Από το ίδιο µενού (Georeferencing) απενεργοποιήστε µε κλικ την επιλογή Auto Adjust.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3) Με τον µεγεθυντικό φακό εστιάστε στην κάτω αριστερή γωνία του χάρτη.  

4) Επιλέξτε το εργαλείο Add Control Points και κάνετε µε αυτό κλικ στην κάτω αριστερή γωνία 

του χάρτη, κι αµέσως µετά δεξί κλικ. Θα σας εµφανιστεί ένα µικρό παράθυρο εντολών. Επιλέξτε 

την  
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5) εντολή Input X and Y για να καταχωρήσετε τις τιµές του γεωγραφικού µήκους και πλάτους 

αντίστοιχα. 

 

6) Πληκτρολογήστε 601302.75 στο Χ και 3909242.32 στο Υ. Επαναλαµβάνοντας τη διαδικασία και 

για τις τρεις άλλες γωνίες του χάρτη και ακολουθώντας τη φορά του ρολογιού, πληκτρολογήστε 

πρώτα κάτω από τη στήλη του Χ και στη συνέχεια κάτω από τη στήλη του Υ τις ακόλουθες τιµές : 

 

601261.03,  3912014.59 (για την πάνω αριστερή γωνία ) 

605816.32,  3912067.14 (για την πάνω δεξιά γωνία) και τέλος 

605849.85,  3909295.28 (για την κάτω δεξιά γωνία) 

. 

7) Επιλέγοντας το κουµπί View Link Table     ενηµερώνεστε για το µέγεθος της απόκλισης (residual) 

που σας επιστρέφει το σύστηµα κάθε φορά που καταχωρείτε ένα σηµείο.  

⇒ Στην περίπτωση που κάποιο σηµείο σας επιστρέφει µεγάλη απόκλιση, είναι πιθανό να µην το έχετε 

καταχωρίσει σωστά και µπορείτε να το σβήσετε επιλέγοντάς το και πατώντας το κουµπί Delete       

στην άνω-δεξιά γωνία του πίνακα. 

 

8) Όταν ολοκληρώσετε επιλέξτε από το µενού Georeferencing την εντολή Update Georeferencing. 

9) Τέλος, σβήστε τα τέσσερα σταυρόνηµα επιλέγοντας την εντολή Georeferencing -> Delete Control 

Points. 

10) Ακολουθήστε τα βήµατα 1-9 και για τον χάρτη 9519_6 πληκτρολογώντας τις τιµές που δίνονται 

παρακάτω: 

 

605848.42  3909295.25 (κάτω αριστερή γωνία) 

605816.38  3912067.97 (πάνω αριστερή γωνία) 

610365.25  3912121.72 (πάνω δεξιά γωνία) 

610393.11  3909350.18 (κάτω δεξιά γωνία) 

 

Επιθεωρήστε τα αποτελέσµατα της διόρθωσης. Οι δύο τοπογραφικοί χάρτες θα πρέπει να βρίσκονται ο 

ένας δίπλα στον άλλο. Εφόσον µείνετε ικανοποιηµένοι µε τη διόρθωση, σώζετε την εργασία αυτή (File -

> Save as) στον φάκελο results και της δίνετε το όνοµα herakleio 
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ΙΙ. Με την παρακάτω διαδικασία θα διορθώσετε µία δορυφορική εικόνα spot της περιοχής του Ηρακλείου 

µε βάση την διορθωµένη δορυφορική εικόνα quickbird 

 

1) Ανοίξτε µία νέα εργασία πατώντας το εικονίδιο       New Map File και προσθέστε στην οθόνη σας 

τις δορυφορικές εικόνες spot και τη quickbird που βρίσκονται αποθηκευµένες στον φάκελο 

Georeferencing. 

2) Εστιάστε σε όλο το εύρος και των δύο εικόνων επιλέγοντας το εργαλείο Full Extent 

3) Βεβαιωθείτε ότι στην µπάρα εργαλείων του Georeferencing και δίπλα στην εντολή Layer 

εµφανίζεται το όνοµα της εικόνας spot.  

4) Βεβαιωθείτε ότι η επιλογή Auto Adjust είναι απενεργοποιηµένη. 

5) Εστιάστε σ’ ένα σηµείο της εικόνας spot που µπορείτε να το ταυτίσετε µε το αντίστοιχο της εικόνας 

quickbird για παράδειγµα µία διασταύρωση δρόµων 

6) Επιλέξτε το εργαλείο Add Control Points και κάνετε κλικ στο σηµείο που έχετε εστιάσει.  

7) Από τον πίνακα περιεχοµένων και µε δεξί κλικ στην εικόνα quickbird επιλέγετε Zoom to Layer για 

να εστιάσετε στη συγκεκριµένη εικόνα και να εντοπίσετε την ίδια περιοχή µε αυτή της εικόνας spot. 

8) Εστιάστε στο αντίστοιχο σηµείο. 

9) Επιλέγετε και πάλι το εργαλείο Add Control Points και κάνετε κλικ.  

10) Επαναλάβετε τη διαδικασία για τουλάχιστον άλλα 2-3 σηµεία 

11) Ελέγχετε την απόκλιση από τον πίνακα σηµείων.  

12) Επιλέξτε Georeferencing -> Update Display. Οι δύο δορυφορικές εικόνες πρέπει τώρα να 

επικαλύπτονται. Tέλος, από το µενού Georeferencing επιλέξτε Rectify, αποδεχτείτε τις 

προεπιλογές και σώστε την εικόνα ως rectifyspot. 

 

⇒ Με την εντολή Rectify δηµιουργείτε από την φωτογραφία που µόλις διορθώσατε ένα νέο αρχείο, το οποίο 

εµπεριέχει –µόνιµα πλέον- την διόρθωση. 
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Ψηφιοποίηση 
 

Ι. ∆ηµιουργία θεµατικής ενότητας σηµείων από πίνακα 
 
΄Εχετε στη διάθεσή σας µια λίστα µε επίκεντρα σεισµών που συνοδεύονται από συντεταγµένες Χ και Υ σε 

σύστηµα ΕΓΣΑ. Το αρχείο βρίσκεται σε µορφή dbf και είναι αποθηκευµένο στον φάκελο Digitising. Για να 

εισάγετε αυτά τα σηµεία στο σύστηµα θα δηµιουργήσετε από αυτό το αρχείο µια θεµατική ενότητα σηµείων 

(point shapefile).  

 

1) Επιλέξτε το κουµπί ArcCatalog      από τη µπάρα εργαλείων του ArcMap για να ανοίξετε τον 

Κατάλογο και να εντοπίσετε το αρχείο earthquakes.dbf στο παράθυρο περιήγησης του Καταλόγου. 

2) Κάντε δεξί κλικ στο αρχείο και επιλέξτε τις εντολές  

   Create Feature Class -> From XY Table.  

 

 

 

 

 

 

 

3) Στο παράθυρο που θα εµφανιστεί βεβαιωθείτε ότι έχουν συµπληρωθεί σωστά από το σύστηµα τα 

ονόµατα των πεδίων της λίστας που φέρουν το Χ και το Υ.  
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4) Προσδιορίστε το ΕΓΣΑ `87 ως σύστηµα συντεταγµένων του νέου θεµατικού χάρτη κάνοντας κλικ 

στο κουµπί Spatial Reference of Input Coordinates... και ακολουθώντας την διαδροµή Select -> 

Projected Coordinate Systems -> National Grids -> Greek Grid.prj-> Apply 

5) Στο πεδίο Output – Specify output shapefile or feature class κάντε κλικ στο εικονίδιο πλοήγησης.  

Πλοηγηθείτε στον φάκελο results, αφήστε το προεπιλεγµένο όνοµα XYearthquakes.shp για το νέο 

αρχείο ως έχει και κάντε κλικ στο κουµπί SAVE. 

6) Έχετε επιστρέψει στο παράθυρο δηµιουργίας του νέου θεµατικού χάρτη. Για να ολοκληρώσετε την 

εργασία δηµιουργίας επιλέξτε ΟΚ. 

7) Επιστρέψτε στο ArcMap και ανοίξτε µια νέα εργασία. Προσθέστε το earthquakes.shp στην 

επιφάνεια εργασίας σας και επιθεωρήστε το αποτέλεσµα. Τέλος, αποθηκεύστε την εργασία σας µε 

το όνοµα Digitising. 

 

 

ΙΙ. Ψηφιοποίηση ∆εδοµένων µε τη Μορφή Σηµείων  
 
Με την ακόλουθη άσκηση θα δηµιουργήσετε µια κενή θεµατική ενότητα και θα καταχωρίσετε σε αυτήν µε 

Ψηφιοποίηση τα τριγωνοµετρικά σηµεία που δίνονται στον τοπογραφικό χάρτη 9519_5 ο οποίος βρίσκεται 

αποθηκευµένος στον φάκελο Digitising.  

 

Α. ∆ηµιουργία shapefile 

 
1. Επιστρέψτε στο ArcCatalog, και επιλέξτε 

µε δεξί κλικ πάνω στον φάκελο results τις 

εντολές New -> Shapefile.  

 

 

 

 

 

 

 

 

 

 

Στο παράθυρο που θα εµφανιστεί  

2. Ονοµάστε τη νέα θεµατική ενότητα (Name: spot_heights), 

3. ∆ηλώστε ότι πρόκειται για ενότητα σηµείων (Feature Type: Point) 
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4. Ορίστε το ελληνικό σύστηµα συντεταγµένων (Edit… -> Select -> Projected Coordinate Systems -

> National Grids -> Greek Grid.prj -> Apply).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. Ολοκληρώστε τη δηµιουργία της νέας ενότητας επιλέγοντας ΟΚ. 

6. Επιστρέψτε στο ArcMap και προσθέστε το spot_heights.shp στην επιφάνεια εργασίας σας.  

 

⇒ Μπορείτε να αποµακρύνετε από την επιφάνεια εργασίας σας θεµατικές ενότητες µε τις οποίες δεν εργάζεστε πλέον 

προκειµένου να µην παρεµβάλλονται στην εργασία σας και σας δηµιουργούν σύγχυση.  

 

Α) Από τον πίνακα περιεχοµένων του ArcMap κάντε δεξί κλικ στην ενότητα που 

επιθυµείτε να αποµακρύνετε και επιλέξτε την εντολή Remove. Η αποµάκρυνση είναι 

µόνο προσωρινή, τα αρχεία σας παραµένουν ως έχουν στον χώρο αποθήκευσης που 

έχετε ορίσει. 

 

B) Από τον πίνακα περιεχοµένων του ArcMap κάντε κλικ στο κουτάκι επιλογής που βρίσκεται 

αριστερά του ονόµατος της ενότητας που επιθυµείτε να αποµακρύνετε. Η ενότητα θα 

εξαιρεθεί από την επιφάνεια εργασίας σας µέχρι να την επανεµφανίσετε οι ίδιοι. 
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Β. ∆ηµιουργία εγγραφών 

 
1. Για να προσθέσετε στην επιφάνεια εργασίας του ArcMap την µπάρα εργαλείων επεξεργασίας 

ακολουθήστε την διαδροµή View -> Toolbars -> Editor 

 
2. Για να ενεργοποιήσετε την µπάρα και να ξεκινήσετε µια εργασία επιλέξτε 

Editor -> Start Editing.  

3. Στο παράθυρο διαλόγου που εµφανίζεται επιλέξτε το αρχείο spot_heights 

και επιλέξτε Start Editing.  

4. Βεβαιωθείτε ότι το αρχείο προς επεξεργασία spot_heights είναι αυτό που 

αναγράφεται στο κενό δίπλα στο Target:. 

5. Βεβαιωθείτε επίσης ότι η αναγραφόµενη εργασία είναι η δηµιουργία νέου 

στοιχείου (Task: Create New Feature). 

6. Εµφανίστε στην οθόνη σας τον τοπογραφικό χάρτη 9519_5.tif. 

 

Στον χάρτη 9519_5 δίνονται 5 τριγωνοµετρικά σηµεία: 

 

Άγιος Μηνάς: 57.50 

Κούλες: 19.83 

Χριστός Ηρακλείου: 70.83 

Άγιος Νικόλαος Αλικαρνασσού: 41.02 

Φυλακαί: 33.17 

 

7. Εστιάστε στο πρώτο τριγωνοµετρικό σηµείο. 

8. Επιλέξτε το εργαλείο Sketch tool      και µε αυτό κάντε κλικ πάνω στο πρώτο τριγωνοµετρικό 

σηµείο.  

9. Επιλέξτε το κουµπί Attributes.      

Εµφανίζεται ένα παράθυρο καταχώρησης των 

χαρακτηριστικών του στοιχείου που µόλις 

ψηφιοποιήσατε, στο οποίο θα προσθέσετε το 

υψόµετρο που του αντιστοιχεί. 

10. Κάντε κλικ στο αριθµητικό πεδίο δίπλα στην 

ιδιότητα Id και πληκτρολογήστε το υψόµετρο 

του τριγωνοµετρικού.  

11. Επιλέξτε Editor -> Save Edits. 

12. Επαναλάβετε τη διαδικασία για τα υπόλοιπα 4 τριγωνοµετρικά που δίνονται στον χάρτη. 

13. Όταν ολοκληρώσετε, επιλέξτε Editor -> Save Edits και Editor -> Stop Editing. 
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⇒ Κατά τη διάρκεια της ψηφιοποίησης, στην περίπτωση που επιθυµείτε να διαγράψετε κάποιο σηµείο το επιλέγετε µε 

το Edit Tool       και επιλέγετε Delete από το πληκτρολόγιο. 

 

Γ. Προσθήκη χαρακτηριστικών (attributes) στην θεµατική ενότητα 

 
Θα προσθέσετε ένα νέο πεδίο στον πίνακα που συνοδεύει τα σηµεία της 

θεµατικής ενότητας spot_heights.shp, προκειµένου να συµπληρώσετε µε 

ελληνικούς χαρακτήρες τα τοπωνύµια που αντιστοιχούν στα 

τριγωνοµετρικά σηµεία. 

 

1. Από τον πίνακα περιεχοµένων του ArcMap επιλέξτε το αρχείο 

spot_heights µε δεξί κλικ και ζητήστε την εντολή Open 

Attribute Table.  

 

 

 

 

 

 

 

 

2. Επιλέξτε το κουµπί Options και κατόπιν την εντολή Add field. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Στο παράθυρο που θα εµφανιστεί συµπληρώστε το όνοµα του πεδίου (Name: Site)  
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4. Από τη λίστα επιλογών για τον τύπο του πεδίου επιλέξτε Text. 

5. Εισάγετε την τιµή 50 για το επιτρεπόµενο σύνολο χαρακτήρων. 

6. Επιλέξτε ΟΚ. Το πεδίο έχει συµπληρωθεί στον πίνακα. 

7. Επιλέξτε Editor -> Start Editing. 

8. Επιλέξτε την ελληνική γλώσσα για τους χαρακτήρες του πληκτρολογίου σας. 

9. Εισάγετε τα τοπωνύµια µε ελληνικούς χαρακτήρες στο πεδίο Site. 

10. Όταν ολοκληρώσετε, τερµατίστε την ψηφιοποίηση µε τις εντολές Editor -> Save Edits και Editor -

> Stop Editing. 

 

 

ΙΙΙ. Ψηφιοποίηση δεδοµένων µε τη µορφή γραµµών (polylines ή arcs) 
 
Εκτελέστε την ακόλουθη διαδικασία για να ψηφιοποιήσετε τις ισοϋψείς από τον τοπογραφικό χάρτη, 

προκειµένου να δηµιουργήσετε στη συνέχεια ένα ψηφιακό µοντέλο εδάφους. 

 

Α. ∆ηµιουργία shapefile 

 
1. Στο ArcCatalog, µέσα στον φάκελο results, δηµιουργήστε ένα νέο shapefile µε το όνοµα Contours. 

2. Oρίστε τον τύπο polyline. 

3. Ορίστε επίσης το ελληνικό σύστηµα συντεταγµένων. 

4. Κατόπιν, προσθέστε το κενό shapefile στο ArcMap. 

5. Ξεκινήστε την διαδικασία ψηφιοποίησης επιλέγοντας Editor -> Start Editing. 

6. Βεβαιωθείτε ότι ως Target έχει επιλεγεί η νέα θεµατική ενότητα Contours και ως Task η 

δηµιουργία νέου στοιχείου (Create New Feature).  

 

Β. Ρύθµιση του περιβάλλοντος Snapping  

 
Πριν αρχίσετε την ψηφιοποίηση των γραµµών, θα ρυθµίσετε το περιβάλλον snapping. Με αυτό τον τρόπο, 

σε περιπτώσεις κλειστών ισοµετρικών καµπύλων, θα ενώνετε γρήγορα και µε ασφάλεια τα ακραία σηµεία 

της γραµµής. 

 

1. Επιλέξτε Editor -> Options και κατόπιν την καρτέλα General.  

2. Στο πεδίο Snapping tolerance πληκτρολογήστε αριθµό π.χ. 0.2  

3. Βεβαιωθείτε ότι από τη λίστα επιλογών, που σας δίνεται ακριβώς δίπλα, έχει οριστεί το map units. 

Αποδεχτείτε τις ρυθµίσεις µε OK. 

4. Στη συνέχεια, επιλέξτε Editor -> Snapping.  

5. Στο επάνω µέρος του παραθύρου που θα εµφανιστεί κάντε κλικ και στα 3 κουτάκια επιλογής 

Vertex, Edge, End, που βρίσκονται δίπλα στο αρχείο Contours. 
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6. Στο κατώτερο τµήµα του παραθύρου κάντε κλικ στα κουτάκια επιλογών που βρίσκονται δίπλα στις 

εντολές Edit Sketch, Edit Sketch Vertices, Edit Sketch Edges. 

 

 

 

 

 

 

 

7. Κλείστε το παράθυρο από το κουµπί Χ στην άνω δεξιά γωνία του παραθύρου. 
 

Γ. ∆ηµιουργία εγγραφών 

 
1. Εστιάστε στην άνω αριστερή γωνία του τοπογραφικού χάρτη και στην αρχή µιας ισοµετρικής 

καµπύλης. 

2. Με το Sketch Tool       ψηφιοποιήστε το πρώτο σηµείο. 

3. Μετακινήστε τον κέρσορα κατά µήκος της ισοµετρικής καµπύλης και ψηφιοποιήστε το επόµενο 

σηµείο κατά τον ίδιο τρόπο.  

4. Συνεχίστε µέχρι να εξαντλήσετε το µήκος της ισοϋψούς και τοποθετήστε το τελευταίο σηµείο µε 

διπλό κλικ. 

5. Από το κουµπί Attributes καταχωρήστε στο πεδίο Id το υψόµετρο που αντιστοιχεί στην ισοµετρική 

καµπύλη που µόλις ψηφιοποιήσατε. 

6. Επιλέξτε Editor -> Save Edits και συνεχίστε µε την επόµενη καµπύλη. 

7. Όταν εξαντλήσετε την επιφάνεια, επιλέξτε Editor -> Save Edits και Editor -> Stop Editing 

 

⇒ ∆ιαγραφή µέρους ή ολόκληρης γραµµής. 

 Στην περίπτωση που επιθυµείτε να σβήσετε κάποιο σηµείο ή ολόκληρη 

γραµµή χρησιµοποιείτε το Edit Tool      και επιλέγετε µε διπλό κλικ το 

σηµείο ή τη γραµµή. Κατόπιν, όταν ο κέρσοράς σας βρίσκεται ακριβώς πάνω 

στο σηµείο θα αλλάξει σχήµα σε τετραγωνισµένο σταυρό. Κάντε δεξί κλικ 

στο σηµείο και επιλέξτε την εντολή Delete Vertex ή Delete Sketch. 

 

⇒ Ψηφιοποίηση µιας γραµµής σε δύο ή περισσότερα µέρη. 

Στην περίπτωση που επιθυµείτε να ψηφιοποιήσετε µία ισοµετρική καµπύλη 

σε δύο µέρη, αφού έχετε τοποθετήσει το τελευταίο σηµείο του πρώτου 

µέρους, µε δεξί κλικ επιλέξτε την εντολή Finish Part. Κατόπιν τοποθετήστε 

το πρώτο σηµείο του δεύτερου µέρους και όλα τα επόµενα µέχρις 

εξαντλήσεως του µήκους της ισοµετρικής καµπύλης µε το γνωστό τρόπο.  
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∆. Επικύρωση της ακρίβειας και της αξιοπιστίας των ψηφιακών δεδοµένων - Τοπολογία 

 
Κατά την ψηφιοποίηση χωρικών πληροφοριών είναι επιθυµητό να διασφαλίζουµε την γεωµετρική και γεωγραφική 
ακρίβεια και αξιοπιστία των ψηφιακών δεδοµένων που παράγουµε. Αυτό µας απαλλάσσει από τυχόν χωρικές 
ανακρίβειες που επιδρούν αρνητικά στη µελλοντική αξιοποίηση και ανάλυση των δεδοµένων. Βασικός παράγοντας για 
την εξασφάλιση της ποιότητας των χωρικών δεδοµένων είναι η ορθή και συνεπής τοποθέτησή τους στο χώρο. Αυτό 
επιτυγχάνεται µε τον ορισµό της Τοπολογίας τους.  
 
Το σύστηµα ArcGIS διαθέτει ένα µηχανισµό τοπολογίας, σύµφωνα µε τον οποίο ένα σύνολο περιοριστικών κανόνων 
και σχέσεων, καθώς και µια σειρά από εργαλεία και τεχνικές, ορίζουν την θέση και την συµπεριφορά των στοιχείων 
που ψηφιοποιούµε (σηµείων, γραµµών, πολυγώνων). Ακόµη, επισηµαίνει τυχόν ανακρίβειες στα ίδια ή και στις σχέσεις 
µεταξύ τους και επικυρώνει την ορθότητα τους σε µία ή και µεταξύ περισσότερων θεµατικών ενοτήτων. 
 
Βασικά σηµεία για την κατανόηση της τοπολογίας είναι τα εξής: 
 
⇒ Κατά τη δηµιουργία της τοπολογίας επισηµαίνετε τις θεµατικές ενότητες που θα συµµετέχουν σε αυτή. Οι 

θεµατικές ενότητες µπορεί να ανήκουν στον τύπο των σηµείων, γραµµών, ή πολυγώνων. Στην τοπολογία οι 
γεωµετρικές σχέσεις που ορίζονται αφορούν περισσότερο τα µέρη που αποτελούν ένα στοιχείο και λιγότερο τα 
στοιχεία καθεαυτά. Τα πολύγωνα αποτελούνται από πλευρές (edges) που ορίζουν τα όρια του κάθε πολυγώνου, από 
κόµβους (nodes) όπου τέµνονται οι πλευρές, και από σηµεία (vertices), που ορίζουν το σχήµα των πλευρών. Κατά 
τον ίδιο τρόπο αντιλαµβανόµαστε ότι οι γραµµές απαρτίζονται από µια πλευρά, τουλάχιστον δύο κόµβους που 
αποτελούν τα άκρα της πλευράς, και από σηµεία που δίνουν το σχήµα της γραµµής. Κατά αναλογία τα σηµεία 
λειτουργούν ως κόµβοι όταν συµπίπτουν µε άλλα στοιχεία σε µια τοπολογία. 

 
⇒ Όταν σε µια τοπολογία υπάρχουν στοιχεία των οποίων τα µέρη επικαλύπτονται ή τέµνονται, οι πλευρές 

και οι κόµβοι που αποτελούν τα µέρη αυτά ανήκουν από κοινού στα στοιχεία αυτά. 
 
 
⇒ Η τοπολογία φέρει 3 παραµέτρους, κανόνες (rules), βαθµολόγηση (rank), και επιτρεπόµενη τιµή 

οµαδοποίησης (cluster tolerance), όπου: 
 

o Οι κανόνες αποτελούν τις χωρικές σχέσεις που επιτρέπονται µεταξύ στοιχείων και ελέγχουν τις 
σχέσεις των στοιχείων που επιτρέπονται εντός µιας θεµατικής ενότητας ή µεταξύ στοιχείων 
διαφορετικών θεµατικών ενοτήτων. Π.χ. ένας κανόνας τοπολογίας µπορεί να ορίζει ότι όλοι οι δρόµοι 
πρέπει να ενώνονται µε άλλους δρόµους και στα δύο άκρα τους, εκτός από τις περιπτώσεις δρόµων 
του τύπου «αδιέξοδο». 

 
o Η βαθµολόγηση των θεµατικών ενοτήτων σε µια τοπολογία ελέγχει τα στοιχεία που θα µετακινηθούν 

κατά την επικύρωση της τοπολογίας εξαιτίας της ένωσης σηµείων που συµπίπτουν. Όταν 
διαφορετικές θεµατικές ενότητες χαρακτηρίζονται από διαφορετικό βαθµό ακρίβειας, π.χ., µία 
ενότητα σηµείων που συλλέχθηκαν µε GPS και µία µε σηµεία που ψηφιοποιήθηκαν από ένα 
σκαναρισµένο χάρτη κλίµακας 1:50000, η βαθµολόγηση µπορεί να βεβαιώσει ότι σηµεία της πρώτης 
δεν θα µετακινηθούν προς και θα συνενωθούν µε σηµεία της δεύτερης. 

 
 
o Η επιτρεπόµενη x, y τιµή οµαδοποίησης είναι η µικρότερη οριζόντια απόσταση µεταξύ σηµείων που 

δεν συµπίπτουν. Τα σηµεία που εµπίπτουν εντός της απόστασης αυτής θεωρούνται ότι συµπίπτουν και 
ενσωµατώνονται. Στην ουσία, η επιτρεπόµενη x, y τιµή οµαδοποίησης ορίζεται για να περιοριστεί η 
πιθανότητα µετακίνησης στοιχείων που έχουν τοποθετηθεί µε ακρίβεια. Η ακρίβεια (precision) ορίζει 
τον αριθµό επιθυµητών µονάδων του συστήµατος για κάθε τιµή µέτρησης σε ένα σύνολο δεδοµένων, 
δηλαδή ορίζει την ανοχή αποθήκευσης της απόστασης µεταξύ συντεταγµένων σε ένα σύνολο 
δεδοµένων. 

 
 
⇒ Η θεµατική ενότητα της τοπολογίας αποτελείται από δύο τύπους στοιχείων, αυτή των «λερωµένων 

περιοχών» (dirty areas) και αυτή των σφαλµάτων (error features),όπου: 
 

o Λερωµένες περιοχές θεωρούνται οι περιοχές που έχουν υποστεί όποια µορφή επεξεργασίας 
(διόρθωση, ανανέωση, προσθήκη, διαγραφή κτλ.) και περιορίζουν την περιοχή που ελέγχεται κατά την 
επικύρωση της τοπολογίας.  
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o Τα σφάλµατα αποτελούν στοιχεία απεικόνισης των εντοπισµένων σηµείων παραβίασης των κανόνων 

τοπολογίας και επιτρέπουν την ανάλογη διαχείριση αυτών των περιπτώσεων είτε µε επεξεργασία 
διόρθωσης είτε µε αποκατάσταση τους ως εξαιρέσεις.  

 
 
 
 
Με τον ακόλουθο τρόπο θα ελέγξετε την ορθή τοπολογία των ισοµετρικών καµπύλων που µόλις 

ψηφιοποιήσατε. Θα δηµιουργήσετε µια χωρική βάση δεδοµένων (personal geodatabase) και µέσα σε αυτή 

ένα σύνολο δεδοµένων (dataset). Στη συνέχεια, θα εξάγετε στο dataset τη θεµατική ενότητα των 

ισοµετρικών καµπύλων. Κατόπιν, θα ορίσετε τους κανόνες τοπολογίας (topology rules) που συνιστούν την 

ορθή χωρική τοποθέτηση των ψηφιοποιηµένων γραµµών. Τέλος, θα επικυρώσετε έναντι αυτών των 

κανόνων την θεµατική ενότητα των ισοµετρικών καµπύλων. 

 

α. ∆ηµιουργία Personal Geodatabase και Feature Dataset.  

 
1. Με δεξί κλικ στον φάκελο results ακολουθήστε την διαδροµή New -> Personal Geodatabase. Το 

νέο οµώνυµο αρχείο θα εµφανιστεί µέσα στο φάκελο. 

2. Κάνετε δεξί κλικ στο αρχείο και εκτελώντας την εντολή Rename ονοµάστε την Βάση 

Digitising.mdb.  

3. Με δεξί κλικ πάνω στη Βάση Digitising 

ακολουθήστε την διαδροµή New -> Feature 

Dataset.  

 

 

 

   

 

 

 

 

4. ∆ώστε στο νέο Dataset το όνοµα Elevation.  

5. Από το κουµπί Edit εισάγετε το σύστηµα συντεταγµένων του contours.shp εκτελώντας τα ακόλουθα 

βήµατα: 

− Edit->Import 

− Πλοηγηθείτε στον φάκελο results όπου βρίσκεται αποθηκευµένο το contours.shp, επιλέξτε 

το συγκεκριµένο αρχείο και κατόπιν το κουµπί Add  

− Βεβαιωθείτε ότι έχει εισαχθεί το ελληνικό σύστηµα ΕΓΣΑ’87 και ολοκληρώστε τις 

ρυθµίσεις σας µε Apply->OK  

6. Ολοκληρώστε τη δηµιουργία του νέου Dataset µε ΟΚ. 
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β. Εξαγωγή (export) θεµατικής ενότητας 

 
1. Από το παράθυρο περιήγησης του ArcCatalog, κάντε δεξί κλικ στο contours.shp και ακολουθήστε 

την διαδροµή Export -> To Geodatabase (single). 

 

 

 

 

 

 

  

 

 

 

2. Στην τοποθεσία όπου θα εξάγετε τη θεµατική ενότητα (Output Location) ορίστε το σύνολο 

δεδοµένων Elevation της Βάσης Digitising, κάνοντας πλοήγηση από το αντίστοιχο εικονίδιο. 

3. Στο όνοµα του νέου αρχείου που θα δηµιουργήσετε µε την εξαγωγή (Output Feature Class Name) 

δώστε το όνοµα contours_2. 

4. Αποδεχτείτε τις ρυθµίσεις σας µε ΟΚ.  

Επιστρέψτε στην Βάση και ανοίξτε το περιεχόµενό της κάνοντας κλικ 

στον σταυρό στα αριστερά της. Εµφανίζεται το σύνολο δεδοµένων 

Elevation. Ανοίξτε το περιεχόµενό του και δείτε ότι περιέχει τη νέα 

θεµατική ενότητα (Feature Class) contours_2. 

 

γ. ∆ηµιουργία Τοπολογίας γραµµών 

 
1. Κάνετε δεξί κλικ στο σύνολο δεδοµένων Elevation και ακολουθήστε την διαδροµή New -> 

Topology. Με αυτό τον τρόπο ανοίγετε µια σειρά από παράθυρα που σας καθοδηγούν στο να 

ορίσετε την επιθυµητή τοπολογία. 

2. Στο πρώτο παράθυρο ονοµάστε την τοπολογία Elevation. Πατήστε Next.  

3. Στο δεύτερο παράθυρο αφήστε την προεπιλεγµένη ρύθµιση ως έχει. Πατήστε Next. 

4. Στο τρίτο, κάνετε κλικ στο κουτάκι επιλογής αριστερά του contours και περάστε στο επόµενο 

παράθυρο. 

5. Αποδεχτείτε την προεπιλεγµένη βαθµολόγηση και περάστε στο επόµενο παράθυρο. 

6. Από το κουµπί Add Rule θα βρεθείτε σε ένα παράθυρο όπου µπορείτε να επιλέξετε τους κανόνες 

που θα συστήσουν την τοπολογία των ισοϋψών. Στο πρώτο πεδίο εµφανίζεται το αρχείο που 

συµµετέχει στην τοπολογία, στην περίπτωσή µας το contours_2. Στο δεύτερο πεδίο επιλέγετε κάθε 

φορά τον κανόνα που επιθυµείτε. Παράλληλα εµφανίζεται η περιγραφή του κανόνα στα δεξιά. 
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7. Επιλέξτε τον κανόνα Must Not Intersect και κάντε κλικ στο κουµπί ΟΚ. 

8. Επαναλάβετε την διαδικασία για να προσθέσετε ακόµη τον κανόνα Must Not Self Intersect. 

9. Όταν τελειώσετε, περάστε στο επόµενο και τελευταίο παράθυρο, επιθεωρήστε τις ρυθµίσεις που 

µόλις ορίσατε, και ολοκληρώστε τη διαδικασία κάνοντας κλικ στο κουµπί Finish. 

10. Το σύστηµα σας ειδοποιεί ότι η τοπολογία έχει δηµιουργηθεί και σας παρακινεί να επικυρώσετε την 

θεµατική ενότητα έναντι των κανόνων που ορίσατε. Αποδεχτείτε την προτροπή. 

 

δ. Επικύρωση Τοπολογίας γραµµών 

 
1. Επιστρέψτε στο ArcMap. 

2. Προσθέστε την τοπολογία που µόλις δηµιουργήσατε. 

3. Το σύστηµα σας προτρέπει να προσθέσετε παράλληλα και 

το αρχείο που συµµετέχει στην τοπολογία. ∆εχτείτε την 

πρόταση. Θα εµφανιστεί το αρχείο των ισοµετρικών 

καµπύλων πιθανόν µε τονισµένα κάποια σηµεία, όπου το 

σύστηµα έχει εντοπίσει παραβιάσεις των κανόνων 

τοπολογίας που έχετε ορίσει. 

4. Στον πίνακα περιεχοµένων ανοίξτε το υπόµνηµα της 

τοπολογίας και ενηµερωθείτε για το πώς απεικονίζεται η κάθε παραβίαση. 

5. Από το µενού Editor της οµώνυµης εργαλειοθήκης ακολουθήστε την διαδροµή More Editing 

Tools -> Topology, προκειµένου να εµφανίσετε την οµώνυµη εργαλειοθήκη. 

 

 

6. Από το Editor ξεκινήστε νέα περίοδο επεξεργασίας. Παράλληλα θα ενεργοποιηθεί και η µπάρα 

εργαλείων της τοπολογίας.  

7. Εστιάστε σε κάποιο από τα εντοπισµένα λάθη σηµείων (point errors) που σηµειώνονται από το 

σύστηµα µε ροζ τετράγωνο. 

8. Επιλέξτε το εργαλείο Fix Topology Error Tool     και κάντε κλικ 

στο τετράγωνο σηµείο. 

9. Με δεξί κλικ σας δίνονται οι επιλογές να εστιάσετε (Zoom To) ή 

να µετακινηθείτε (Pan To) στην παραβίαση, να επιλέξετε τις 

γραµµές που µετέχουν στην παραβίαση (Select Features) και να 

δείτε ποιός είναι ο κανόνας που έχει παραβιαστεί (Show Rule 

Description). Ακόµη σας δίνονται κάποιοι τρόποι να επέµβετε 

στην παραβίαση, ένας από τους οποίους π.χ. είναι να επισηµάνετε 

πως η συγκεκριµένη περίπτωση πρόκειται για εξαίρεση του 

κανόνα (Mark As Exception). 



ΕΙΣΑΓΩΓΗ ΣΤΑ ΓΕΩΓΡΑΦΙΚΑ ΣΥΣΤΗΜΑΤΑ ΠΛΗΡΟΦΟΡΙΩΝ 
ΣΥΝΤΟΜΗ ΕΠΙΣΚΟΠΗΣΗ ΣΤΗ ΧΡΗΣΗ ΤΟΥ ESRI ARCGIS 9.X 

ΕΡΓΑΣΤΗΡΙΟ ΓΕΩΦΥΣΙΚΗΣ-∆ΟΡΥΦΟΡΙΚΗΣ ΤΗΛΕΠΙΣΚΟΠΗΣΗΣ & ΑΡΧΑΙΟ-ΠΕΡΙΒΑΛΛΟΝΤΟΣ 
ΙΝΣΤΙΤΟΥΤΟ ΜΕΣΟΓΕΙΑΚΩΝ ΣΠΟΥ∆ΩΝ 
Ι∆ΡΥΜΑ ΤΕΧΝΟΛΟΓΙΑΣ & ΕΡΕΥΝΑΣ (ΙΤΕ) 

21

 

10. Επιστρέψτε στο µενού Editor -> Options -> General -> Snapping Tolerance και µειώστε την 

αριθµητική τιµή που είχατε ορίσει στη διάρκεια της ψηφιοποίησης των ισοϋψών και ολοκληρώστε 

τη νέα ρύθµιση µε ΟΚ. Ελέγξτε επίσης την κατάσταση snapping από το µενού Editor -> 

Snapping. 

11. Με το Edit Tool κάντε διπλό κλικ και επιλέξτε το σηµείο παράβασης. Οι γραµµές που συµµετέχουν 

στην παραβίαση θα πάρουν τη µορφή συνδεόµενων σηµείων, ενώ ο κέρσοράς σας, όταν τον 

τοποθετήσετε πάνω στο σηµείο παράβασης, θα αλλάξει σε τετραγωνισµένο σταυρό. 

12. Σύρετε µε τον κέρσορά σας το σηµείο στην κατεύθυνση που θεωρείτε σωστή. 

13. Κάνετε κλικ εκτός της καµπύλης για να επανέλθει αυτή στην αρχική της µορφή. Επιλέξτε από την 

µπάρα της τοπολογίας το κουµπί Validate Topology In Current Extent.     Η παραβίαση θα έχει 

αποκατασταθεί. 

14. Εστιάστε σε µία παράβαση γραµµής. Πιθανόν το λάθος να οφείλεται σε τµήµα της καµπύλης που 

έχει διπλό-ψηφιοποιηθεί. 

15. Επιλέξτε την καµπύλη µε το Edit Tool και διαγράψτε το σηµείο (ή σηµεία) που προκαλούν αυτή 

την κατάσταση. 

16. Αποµακρυνθείτε από την καµπύλη όπως και προηγουµένως προκειµένου να την επαναφέρετε στην 

αρχική της µορφή. 

17. Επαληθεύστε την τοπολογία κατά τον γνωστό τρόπο. 

18. Συνεχίστε µε άλλα τυχόν λάθη που επισηµαίνονται. 

19. Όταν ολοκληρώσετε επιλέξτε το κουµπί Zoom to Full Extent     και κατόπιν επαληθεύστε για 

ακόµη µια φορά την τοπολογία µε το κουµπί Validate Entire Topology. 

 

 

ΙV. Ψηφιοποίηση δεδοµένων µε τη µορφή πολυγώνων (polygons) 

 
 
Για την ψηφιοποίηση πολυγώνων ακολουθήστε την εξής διαδικασία: 

 

Α. ∆ηµιουργία Feature Class 

 
1. Στο ArcCatalog, µέσα στον φάκελο results δηµιουργήστε µία νέα κενή θεµατική ενότητα µε το 

όνοµα geology στον τύπο του πολυγώνου. Θυµηθείτε να ορίσετε το ελληνικό σύστηµα 

συντεταγµένων. 

2. Μέσα στη Βάση Digitising δηµιουργήστε ένα νέο σύνολο δεδοµένων (Feature Dataset) µε το 

όνοµα Geology_set, για το οποίο ορίστε το σύστηµα συντεταγµένων της θεµατικής ενότητας 

geology που µόλις δηµιουργήσατε (πρβλ. α.5, σελ. 18). 

3. Εξάγετε την θεµατική ενότητα geology.shp στο Dataset Geology µε το όνοµα geology_2 (πρβλ. β., 

σελ. 19) 
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Β. Ορισµός Τοπολογίας πολυγώνων 

 
∆ηµιουργήστε στο Geology Dataset µια τοπολογία µε όνοµα Geology ορίζοντας τους κανόνες Must Not 

Overlap και Must Not Have Gaps (για τη δηµιουργία Τοπολογίας πρβλ ενότητα Ψηφιοποίηση, ΙΙΙ, ∆, γ. 

∆ηµιουργία Τοπολογίας γραµµών, σελ. 19). Οι κανόνες αυτοί θα αποτρέψουν ή θα περιορίσουν το 

ενδεχόµενο κατά την ψηφιοποίηση των γεωλογικών σχηµατισµών να υπάρξουν περιπτώσεις επικάλυψης του 

ενός πολυγώνου µε το άλλο ή δηµιουργίας κενών µεταξύ τους. 

 

Γ. ∆ηµιουργία εγγραφών 

1. Επιστρέψτε στο ArcMap. 

2. Προσθέστε στην επιφάνεια εργασίας σας τον γεωλογικό χάρτη anogeia.tif που βρίσκεται 

αποθηκευµένος στον φάκελο Digitising. 

3. Προσθέστε, ακόµη, την τοπολογία της γεωλογίας µε τη συνοδευόµενη κενή θεµατική ενότητα 

geology. 

4. Από το µενού Editor ξεκινήστε µια νέα περίοδο επεξεργασίας. 

5. Ρυθµίστε το περιβάλλον snapping µε χρήση των µενού Snapping και Options του Editor (πρβλ 

ενότητα Ψηφιοποίηση, ΙΙΙ, Β. Ρύθµιση του περιβάλλοντος snapping, σελ. 15). 

6. Βεβαιωθείτε ότι θα επεξεργαστείτε το αρχείο geology και ότι η επιλεγµένη εργασία σας είναι η 

Create New Feature. 

7. Εστιάστε και ψηφιοποιήστε το εξωτερικό πολύγωνο που 

περιγράφει τους γεωλογικούς σχηµατισµούς. 

8. Όταν ολοκληρώσετε, αποθηκεύστε την εργασία σας. 

9. Κάνετε δεξί κλικ στο πολύγωνο που εµφανίζεται κάτω 

από το όνοµα του αρχείου στον πίνακα περιεχοµένων προκειµένου να επιλέξτε διάφανο χρώµα (No 

Color) για το εσωτερικό του. 

10. Κατόπιν, µε το Edit Tool    επιλέξτε µε µονό κλικ το πολύγωνο που µόλις ψηφιοποιήσατε. Το 

περίγραµµα του πολυγώνου θα χρωµατιστεί γαλάζιο. 

11. Από τη λίστα εργασιών του Editor επιλέξτε Cut Polygon Features.  

 

 

 

 

 

 

 

12. Κρατώντας πάντα επιλεγµένο το εξωτερικό πολύγωνο, ψηφιοποιήστε τα εσωτερικά πολύγωνα 

«κόβοντας» σταδιακά από το εξωτερικό περίγραµµα. 
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13. Θυµηθείτε να καταχωρείτε τον κωδικό κάθε γεωλογικού σχηµατισµού στο πεδίο Id του 

συνοδευόµενου πίνακα χαρακτηριστικών της θεµατικής ενότητας. 

14. Ανά τακτά διαστήµατα αποθηκεύετε την εργασία σας και επαληθεύετε την τοπολογία.  

 

∆. Επικύρωση Τοπολογίας πολυγώνων 

 
Ο έλεγχος της τοπολογίας καθώς και η διόρθωση παραβάσεων γίνεται κατά τον γνωστό τρόπο (πρβλ. 

Ενότητα Ψηφιοποίηση, ΙΙΙ, ∆, δ.Επικύρωση Τοπολογίας Γραµµών, σελ. 20). Το σύστηµα σας δίνει τη 

δυνατότητα µε προεπιλεγµένες εκδοχές να επαναφέρετε την ορθή τοπολογία, αφαιρώντας (subtract), 

συγχωνεύοντας (merge), δηµιουργώντας νέο πολύγωνο (Create New Feature), ή χαρακτηρίζοντας την 

περίπτωση κατ`ανάγκη ως εξαίρεση (Mark as Exception). Π.χ. Συχνά, ιδιαίτερα στις περιπτώσεις 

επικάλυψης, δηµιουργούµε νέο πολύγωνο από την επικάλυψη και το συγχωνεύουµε µε το κατάλληλο 

πολύγωνο . 
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∆ιαχείριση θεµατικών ψηφιακών δεδοµένων 

 
Σύναψη διαφορετικών θεµατικών ενοτήτων του ίδιου σχήµατος (Append)  

 

Σ΄αυτή την άσκηση θα δείτε πως µπορείτε να ενώσετε 4 θεµατικές ενότητες (shapefiles) που εµπεριέχουν 

ψηφιοποιηµένες ισοϋψείς γειτονικών περιοχών σ’ ένα ενιαίο αρχείο, επισυνάπτοντας την πληροφορία που 

περιλαµβάνουν οι 3 από αυτές σ΄αυτήν της τέταρτης, η οποία και θα οριστεί ως εξαγόµενο αρχείο. 

 

1. Ανοίγετε ένα νέο project στο ArcMap και προσθέτετε τις θεµατικές ενότητες contours1, contours2, 

contours3 και contours4 που βρίσκονται στον φάκελο C/seminars/GIS/Data_Management 

2. Στη συνέχεια εµφανίζετε το σύνολο των εργαλειοθηκών του ArcToolbox πατώντας µε το ποντίκι 

στο αντίστοιχο εικονίδιο µε το βαλιτσάκι  

 

3. Ανοίγετε την εργαλειοθήκη Data Management Tools πατώντας πάνω στο σταυρό, εµφανίζετε τις 

εντολές που βρίσκονται κάτω από τον τίτλο General µε τον ίδιο τρόπο και επιλέγετε την εντολή 

Append  

 

 

 

 

 

 

, 

 

 

 

 

 

4. Στο παράθυρο διαλόγου που εµφανίζεται επιλέγετε ως Input Features πατώντας πάνω στο βελάκι 

τα αρχεία contours1, contours2 contours3 

5. ως Output Features το contours4 και πατάτε ΟΚ 

 

Τώρα το αρχείο contours4 περιλαµβάνει τις ισοϋψείς και των τεσσάρων τοπογραφικών χαρτών που 

έχουν ψηφιοποιηθεί. 
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Κλείνετε το παράθυρο ελέγχου που µας πληροφορεί αν το πρόγραµµα εκτέλεσε επιτυχώς την εντολή που 

του δώσατε και εξετάζετε τα αποτελέσµατα στον ArcMap. 

 

⇒ Σε περίπτωση που θέλετε να επισυνάψετε σε µια θεµατική ενότητα (στη συγκεκριµένη περίπτωση 

στο contours4) περισσότερες θεµατικές ενότητες συνεχίζετε να προσθέτετε τα αρχεία αυτά κάτω 

από το Input Features . 

⇒ Αν θέλετε να επισυνάψετε θεµατικές ενότητες τις οποίες δεν έχετε προσθέσει στο project που είναι 

ανοιχτό, µπορείτε να τις επιλέξετε µε πλοήγηση πατώντας πάνω στο αντίστοιχο εικονίδιο 

⇒ Επίσης αν κάνετε λάθος και προσθέσετε ένα αρχείο το οποίο δεν θέλετε να ενωθεί στο αρχείο που 

έχετε ορίσει ως Output Feature το επιλέγετε και πατάτε διαγραφή 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Σηµείωση 

Για να ενώσετε θεµατικές ενότητες θα πρέπει αυτές να ανήκουν στον ίδιο διανυσµατικό τύπο. ∆εν µπορείτε για 

παράδειγµα να ενώσετε γραµµές µε πολύγωνα παρά µόνο γραµµές µε γραµµές, πολύγωνα µε πολύγωνα και σηµεία µε 

σηµεία. 

 

 

Περικοπή των ορίων µίας θεµατικής ενότητας (Clip) 

 

Η άσκηση αυτή έχει σαν σκοπό τη διαγραφή εγγραφών από µία θεµατική ενότητα, οι οποίες τυγχάνουν να 

βρίσκονται εκτός των ορίων της περιοχής του µελέτης. Πιο αναλυτικά, θα δούµε πως µπορούµε να  
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αποµονώσουµε τα επίκεντρα των σεισµών που σηµειώθηκαν στα γεωγραφικά όρια της Κρήτης, 

χρησιµοποιώντας σαν µάσκα ένα αρχείο µε τη µορφή πολυγώνου που περιλαµβάνει τις ακριβείς 

συντεταγµένες των ορίων του νησιού. 

 

1. Στον ArcMap προσθέτετε το shapefile µε το όνοµα crete που βρίσκεται αποθηκευµένο στον φάκελο 

Data_Management και το αρχείο των σεισµών που έχετε αποθηκεύσει στον φάκελο results σε µία 

από τις προηγούµενες ασκήσεις. 

2. Στο παράθυρο του ArcToolbox ανοίγετε την εργαλειοθήκη Analysis Tools, εµφανίζετε τις εντολές 

που βρίσκονται κάτω από τον τίτλο Extract και επιλέγετε την εντολή Clip 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Στο παράθυρο διαλόγου επιλέγετε ως Input Features  το αρχείο µε τους σεισµούς earthquakes, 

4. ως Clip Features  το shapefile που δείχνει την περιοχή της Κρήτης crete (Clip Features  µπορούν να 

θεωρηθούν µόνο θεµατικές ενότητες µε τη µορφή πολυγώνου)  

5. ενώ στο Output Feature Class κάνοντας πλοήγηση ορίζετε το πού και µε ποιο όνοµα θα σώσετε το 

νέο αρχείο  

c:\seminars\GIS\results\earthquakes_Clip και πατάµε ΟΚ 

 

Κλείνετε το παράθυρο ελέγχου που σας πληροφορεί αν το πρόγραµµα εκτέλεσε επιτυχώς την εντολή που 

έλαβε και παρατηρείτε ότι στο ArcMap έχει προστεθεί το νέο αρχείο που µόλις δηµιουργήθηκε. 
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∆ηµιουργία ζωνών επιρροής (Buffer) 

 

Σκοπός της άσκησης είναι η δηµιουργία ζωνών επιρροής ορίζοντας ακτίνα σε συγκεκριµένη χιλιοµετρική 

απόσταση. Πιο συγκεκριµένα, θα δηµιουργήσετε ζώνες επιρροής των ρηγµάτων καθώς και των επικέντρων 

σεισµών του νησιού της Κρήτης. 

 

1. Σ’ένα νέο project στο ArcMap προσθέτετε τη θεµατική ενότητα µε τα ρήγµατα 

C/seminars/GIS/Data_Management/faults 

2. Στο παράθυρο του ArcToolbox ανοίγετε την εργαλειοθήκη Analysis Tools, εµφανίζετε τις εντολές 

που βρίσκονται κάτω από τον τίτλο Proximity και επιλέγετε την εντολή Buffer     

3. Στο παράθυρο διαλόγου επιλέγετε ως Input Features το shapefile faults 

4. στο Output Feature Class προσδιορίζετε το όνοµα και την τοποθεσία του νέου αρχείου που θα 

περιλαµβάνει τις ζώνες επιρροής c:\seminars\GIS\results\faults_Buffer  

5. ως Distance [value or field] επιλέγετε το Linear Unit και πληκτρολογείτε την τιµή 1000 ώστε να 

ορίσετε σαν ακτίνα του buffer zone τα 1000 µέτρα 

6. στις παραµέτρους Side Type και End Type προσδιορίζετε τον τρόπο µε τον οποίο θα 

δηµιουργηθούν οι ζώνες επιρροής. Όταν τα γεωγραφικά δεδοµένα, των οποίων η επιρροή µας 

ενδιαφέρει, είναι γραµµές έχουµε 3 επιλογές όσον αφορά το Side Type 

• FULL η ζώνη που θα δηµιουργηθεί θα εκτείνεται γύρω από τα θεµατικά δεδοµένα στη 

συγκεκριµένη περίπτωση τα ρήγµατα  

• LEFT η ζώνη που θα δηµιουργηθεί θα εκτείνεται σύµφωνα µε την τοπολογία αριστερά των 

θεµατικών δεδοµένων 

 

• RIGHT η ζώνη που θα δηµιουργηθεί θα εκτείνεται σύµφωνα µε την τοπολογία δεξιά των 

θεµατικών δεδοµένων 

      Όσον αφορά το End Type έχουµε να επιλέξουµε ανάµεσα στα εξής 

• ROUND το πολύγωνο που θα απεικονίζει τη ζώνη επιρροής θα έχει ηµικυκλικό σχήµα 

• FLAT το πολύγωνο που θα απεικονίζει τη ζώνη επιρροής θα ορίζεται από ευθείες γραµµές  

      αφήνετε τις επιλογές FULL και ROUND αντίστοιχα 
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7. στην παράµετρο Dissolve Type διευκρινίζετε αν επιθυµείτε να διαγραφούν πιθανές επικαλύψεις 

• NONE διατηρείται η αρχική µορφή των ζωνών επιρροής χωρίς να λαµβάνονται υπόψη οι 

επικαλύψεις 

• ALL ενοποιούνται όλα τα buffers σε µία εγγραφή και σβήνονται όλες οι επικαλύψεις 

• LIST καταργούνται οι επικαλύψεις µε βάση συγκεκριµένο πεδίο που προσδιορίζετε στο 

Dissolve Field(s)  

8.  διαλέγετε LIST ενεργοποιώντας τα πλαίσια επιλογών που υπάρχουν κάτω από τον τίτλο Dissolve 

Field(s) όπου επιλέγετε το πλαίσιο δίπλα στο FID και πατάτε ΟΚ 

Κλείνετε το παράθυρο ελέγχου και εξετάζετε τα αποτελέσµατα στον ArcMap. 

 

Επαναλάβετε τη διαδικασία για τα επίκεντρα σεισµών και πειραµατιστείτε µε την ακτίνα οριοθέτησης των 

ζωνών επιρροής. 
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Αναλύσεις Χωρικών ∆εδοµένων 

 
Σε αυτήν την ενότητα επισηµαίνονται µερικά βασικά σηµεία που αποτελούν αναγκαία βήµατα της προετοιµασίας 

του περιβάλλοντος ανάλυσης χωρικών δεδοµένων του ArcGIS. Αρχικά, θα ρυθµίσετε το περιβάλλον ανάλυσης 

σύµφωνα µε τις παραµέτρους που επιβάλλει ο τύπος της ανάλυσης που επιθυµείτε να πραγµατοποιήσετε. Επίσης, 

θα µάθετε πώς να ορίζετε το γεωγραφικό εύρος και να χρησιµοποιείτε µάσκα για τις αναλύσεις σας, ώστε τα 

αποτελέσµατα να περιορίζονται στην εκάστοτε περιοχή ενδιαφέροντος. 

 
 

Ρυθµίσεις περιβάλλοντος ανάλυσης 
Πριν ξεκινήσετε να εφαρµόζετε οποιοδήποτε τύπο ανάλυσης στα δεδοµένα σας θα προετοιµάσετε και θα ορίσετε το 
περιβάλλον ανάλυσης του συστήµατος. Θα ορίσετε εξαρχής την τοποθεσία εργασίας και αποθήκευσης των 
παραγόµενων αρχείων (working directory). Θα ορίσετε την έκταση (extent) της ανάλυσης, δηλαδή τη διάσταση της 
επιφάνειας που θα λαµβάνει υπ`όψη το σύστηµα στους υπολογισµούς του. Ακόµη, θα εφαρµόσετε τη µάσκα ανάλυσης 
για τoυς υπολογισµούς σας και θα επιβάλλετε τα αποτελέσµατά σας να προβάλλονται µε βάση το ελληνικό γεωδαιτικό 
σύστηµα. Τέλος θα προσδιορίσετε την διάσταση των κελιών (cell size) που συνθέτουν τα αρχεία αυτά. 
 

Ρυθµίστε το περιβάλλον ανάλυσης µε τον εξής τρόπο: 

1. Ακολουθήστε την πορεία Spatial Analyst -> Options.  

2. Σας εµφανίζεται ένα παράθυρο µε τρεις καρτέλες. 

3. Στην πρώτη, General: 

 Ορίστε ως χώρο εργασίας και 

αποθήκευσης των αρχείων σας 

(Working Directory) τον 

προσωπικό σας υποφάκελο 

κάνοντας πλοήγηση από το 

ανάλογο εικονίδιο στο 

C:\seminars\GIS\results 

 Eφαρµόστε ως µάσκα ανάλυσης 

(Analysis Mask) το αρχείο crete 

που βρίσκετε αποθηκευµένο στον 

υποφάκελο 

C:\seminars\GIS\Spatial_AnalysisI  

 Επιλέξτε το σύστηµα 

συντεταγµένων, στο οποίο επιθυµείτε να προβάλλονται τα προϊόντα της ανάλυσης, να είναι το 

ίδιο µε τα πρωτογενή δεδοµένα (1η επιλογή). 

 Τέλος, επιλέξτε να δέχεστε προειδοποίηση από το σύστηµα στην περίπτωση που κατά την 

ανάλυση υπάρξει τυχόν η ανάγκη να διορθωθεί γεωγραφικά κάποιο από τα συµµετέχοντα 

αρχεία. 
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4. Στη δεύτερη καρτέλα, Extent: 

 Ορίστε την έκταση των νέων αρχείων 

χρησιµοποιώντας τη µάσκα ανάλυσης 

επιλέγοντας από τη λίστα Same As 

Layer “crete” . 

 

 

 

 

 

 

 

 

 

 

5. Με την τρίτη καρτέλα, Cell Size: 

 Καθορίστε τη διάσταση των κελιών των 

rasters που προκύπτουν από την ανάλυση 

επιλέγοντας την εντολή As Specified 

Below και εισάγετε την τιµή 200. 

 

 

 

 

 

 

 

 

 Ολοκληρώστε τις ρυθµίσεις σας µε ΟΚ. 

 

 

Εφαρµογές Παρεµβολής Τιµών 

 
Στην άσκηση που ακολουθεί θα δηµιουργήσετε χάρτες επιφάνειας της µέσης θερµοκρασίας που σηµειώθηκε στην 

Κρήτη τη δεκαετία του 1990 για τους µήνες Αύγουστο, Σεπτέµβριο, Οκτώβριο, Νοέµβριο και ∆εκέµβριο. Η 

πραγµατοποίηση των χαρτών αυτών θα γίνει µε τη µέθοδο της παρεµβολής τιµών (interpolation) στα δεδοµένα που 

έχουµε από µετρήσεις σταθµών των ΕΜΥ και ΥΕΒ. Το πρόγραµµα λαµβάνοντας υπόψη τις υπάρχουσες µετρήσεις και  
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µε τη χρήση αλγορίθµων υπολογίζει τις θερµοκρασίες που επικρατούσαν σε όλο το εύρος του νησιού για τη χρονική 

περίοδο που µας ενδιαφέρει. Αξίζει να σηµειωθεί ότι δεν µας δίνουν όλοι οι σταθµοί µετρήσεις για όλους τους µήνες. 

Κατά συνέπεια, πρέπει να προσδιορίσουµε ποιοι σταθµοί είναι εκείνοι των οποίων οι µετρήσεις θα συµπεριληφθούν 

στην ανάλυση για τον κάθε µήνα.  

 

 

Επιλογή εγγραφών µε βάση τα χαρακτηριστικά τους 

1. Ανοίγετε µία νέα εργασία στον ArcMap προσθέτετε το αρχείο stations από το 

c:\seminars\GIS\Spatial_AnalysisI, το επιλέγετε µε το ποντίκι από τον πίνακα περιεχοµένων και 

κάνετε δεξί κλικ για να 

ανοίξετε τον πίνακα 

χαρακτηριστικών (Open 

Attribute Table). 

2. Βρίσκετε το πεδίο µε το 

όνοµα ΑΥΓ_1990 κάνετε 

δεξί κλικ πάνω στο όνοµα 

του πεδίου και διαλέγετε 

Sort Ascending από τη 

λίστα επιλογών που 

εµφανίζεται. Παρατηρείτε 

ότι στην κορυφή του πίνακα 

έχουν συγκεντρωθεί όλες οι 

µετρήσεις αφήνοντας πίσω 

τις ψεύτικες τιµές.  

3. Επιλέγετε τις εγγραφές µε 

τις πραγµατικές τιµές 

κάνοντας αρχικά κλικ στο 

µικρό κουτάκι που βρίσκετε 

στα αριστερά της πρώτης εγγραφής, στην αρχή του πίνακα, και στη συνέχεια ολισθαίνοντας το 

ποντικί µέχρι και την τελευταία εγγραφή που περιλαµβάνει µέτρηση. 

4. Κλείνετε τον πίνακα και βλέπετε στο παράθυρο επισκόπησης ότι οι σταθµοί που περιλαµβάνουν 

τιµές θερµοκρασίας για τον Αύγουστο του 1990 έχουν χρωµατιστεί θαλασσί. 

5. Από το κύριο µενού του προγράµµατος επιλέγετε View ->Toolbars ->Spatial Analyst για να 

εµφανίσετε µία σειρά εντολών που αφορούν χωρικές αναλύσεις 

6. Από το µενού του Spatial Analyst ακολουθείτε τη διαδροµή ->Interpolate to Raster  -> Inverse 

Distance Weighted  
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Στο παράθυρο διαλόγου που παρουσιάζεται στην οθόνη θέτουµε τις παραµέτρους που ζητούνται. 

 Η θεµατική ενότητα σηµείων Input 

points: που θα χρησιµοποιηθεί στην 

ανάλυση είναι το stations 

 Το πεδίο που περιλαµβάνει τις τιµές 

για τη δηµιουργία επιφάνειας Z 

value field: είναι το AΥΓ_1990 

 Η παράµετρος Power ρυθµίζει τη 

βαρύτητα που έχουν οι υπάρχουσες 

µετρήσεις στον υπολογισµό των 

παρεµβαλλόµενων τιµών σύµφωνα 

µε την µεταξύ τους απόσταση. 

Επιλέγοντας µια υψηλή τιµή 

δίνουµε µεγαλύτερη έµφαση στους 

γειτονικούς σταθµούς, οπότε και η 

παραγόµενη επιφάνεια 

χαρακτηρίζεται περισσότερο από 

τοπική λεπτοµέρεια και δεν 

εµφανίζεται ιδιαίτερα οµαλοποιηµένη. Αντίθετα, µία χαµηλή τιµή έχει σαν αποτέλεσµα τη 

µεγαλύτερη επιρροή των πιο αποµακρυσµένων σταθµών και τη δηµιουργία µιας πιο εξοµαλυµένης 

επιφάνειας. Το 2 είναι ο αριθµός που χρησιµοποιείται τις περισσότερες φορές και θα 

χρησιµοποιήσετε και στην άσκηση αυτή. 

 Στη συνέχεια έχετε τη δυνατότητα να προσδιορίσετε τον τύπο της ακτίνας αναζήτησης (Search 

radius type) περιορίζοντας τον αριθµό των µετρήσεων που θα συµπεριληφθούν στον υπολογισµό 

των τιµών του κάθε κελιού της παραγόµενης επιφάνειας. Εφαρµόζοντας µεταβλητή ακτίνα (Search 

radius type: Variable), είστε σε θέση να ορίσετε τον αριθµό των σταθµών που θέλετε να ληφθούν 

υπόψη στον υπολογισµό αυτό, θέτοντας προαιρετικά και το µέγιστο της απόστασης πέρα από την 

οποία η αναζήτηση των σταθµών θα λάβει τέλος. Αντιστρόφως, εφαρµόζοντας σταθερή ακτίνα 

(Search radius type:Fixed), το πρόγραµµα παίρνει την εντολή να υπολογίσει µόνο τις µετρήσεις 

των σταθµών που βρίσκονται εντός της ακτίνας που του προσδιορίζετε, ενώ παράλληλα τηρεί το 

ελάχιστο του αριθµού αυτών που του έχετε δώσει. Αποδέχεστε τις προεπιλογές θέτοντας µεταβλητή 

ακτίνα αναζήτησης και υπολογισµό των τιµών µέχρι και 12 σταθµών. 

 Το πρόγραµµα µας δίνει ακόµα τη δυνατότητα να χρησιµοποιήσουµε µια επιπλέον θεµατική 

ενότητα γραµµών η οποία θα υποδεικνύει περιοχές όπου δεν θα θέλαµε να παρεµβάλλονται τιµές. 

Στην παρούσα άσκηση δεν θα συµπεριλάβετε κανένα τέτοιο αρχείο. 

 Τέλος, αφήνετε την τιµή της διάστασης κελιών Output cell size στα 200 µέτρα όπως την είχατε 

ρυθµίσει πρωτύτερα από το Options και ονοµάζετε το εξαγόµενο αρχείο Output raster aug_1990. 
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Ακολουθήστε την ίδια διαδικασία και για τους υπόλοιπους µήνες (Σεπτέµβριο, Οκτώβριο, Νοέµβριο, 

∆εκέµβριο) και συγκρίνετε τα αποτελέσµατα. 

 

 

Μετατροπή των προσωρινών αρχείων σε µόνιµα 
Σε περίπτωση που δεν δώσετε όνοµα στα παραγόµενα αρχεία το σύστηµα, ως προεπιλογή, τα αποθηκεύει πρόσκαιρα 
σε ανάλογο προσωρινό χώρο αποθήκευσης, απ`όπου χάνονται µε τον τερµατισµό της λειτουργίας του υπολογιστή.  
Οι προσωρινά σωζόµενες επιφάνειες (Temporary), µπορούν να µετατραπούν σε µόνιµες (Permanent) µε 

τους εξής τρόπους: 

 

1. Από τον πίνακα περιεχοµένων του ArcMap, κάνοντας δεξί κλικ 

στο προσωρινό αρχείο επιλέγετε την εντολή Make Permanent. 

Στο παράθυρο που θα σας εµφανιστεί, αναζητήστε την τοποθεσία 

αποθήκευσης που επιθυµείτε και δώστε κατάλληλο όνοµα στο 

αρχείο. Αποδεχτείτε τις ρυθµίσεις σας µε ΟΚ.  

 

 

 

 

 

 

2. Εκτελώντας την εντολή Save As από το µενού File του ArcMap αποθηκεύετε την εργασία σας και 

κατά συνέπεια µετατρέπετε σε µόνιµα όλα τα προσωρινά αρχεία που συµµετέχουν σε αυτήν. 
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Αναλύσεις Ψηφιακού Μοντέλου Εδάφους 

 
 
Ι. ∆ηµιουργία ΤΙΝ  
Τα δεδοµένα σε µορφή Triangulated Irregular Networks (ΤΙΝ) χρησιµοποιούνται στην παρουσίαση και ανάλυση 
επιφανειών. Περιλαµβάνουν ακανόνιστα διασπαρµένα σηµεία που διαθέτουν συντεταγµένες x,y και τιµή z. Μια σειρά 
από άκρα ενώνουν τα σηµεία αυτά και συνθέτουν τρίγωνα. Το παραγόµενο µωσαϊκό τριγώνων σχηµατίζει µια συνεχή 
επιφάνεια τριγωνικών πλευρών, κάθε µια από τις οποίες διαθέτει συγκεκριµένη κλίση και προσανατολισµό.  
 
Με την ακόλουθη διαδικασία θα δηµιουργήσετε ένα ΤΙΝ από τις ισοϋψείς που έχετε ψηφιοποιήσει. 

1. Ανοίξτε µια νέα εργασία από το ArcMap και εισάγετε τις θεµατικές ενότητες contours4 από το 

φάκελο results και herakleio_mask από το φάκελο 3D_Analysis . 

2. Προσθέστε την µπάρα εργαλείων 3D Analyst από το View ->Toolbars. 

3. Από τη λίστα εντολών του 3D Analyst επιλέξτε Create/Modify TIN -> Create TIN from 

Features. 

 

 

 

 

 

 

 

 

4. Στο παράθυρο δηµιουργίας του ΤΙΝ, που θα εµφανιστεί, εισάγετε τις θεµατικές ενότητες contours4 

και herakleio_mask κάνοντας κλικ στα πλαίσια επιλογής που βρίσκονται δίπλα στα αρχεία. 

5. Επιλέγετε πρώτα το αρχείο contours4 και κρατώντας το επιλεγµένο συµπληρώνετε Ιd στο Height 

Source, στα δεξιά του παραθύρου, ώστε το σύστηµα να αντλήσει τις τιµές υψοµέτρου από το 

ανάλογο πεδίο του πίνακα του contours4. Στο Triangulate as ορίστε Soft Line ως τον τρόπο µε τον 

οποίο θα προστεθούν τα δεδοµένα στο ΤΙΝ. 

6. Στη συνέχεια επιλέγετε το αρχείο herakleio_mask και κρατώντας το επιλεγµένο συµπληρώνετε 

Height Source:Ιd και Triangulate as: soft clip.  

7. Τέλος, αναζητήστε τον φάκελο c:\seminars\GIS\results και αποθηκεύστε εκεί το ΤΙΝ κρατώντας το 

προεπιλεγµένο όνοµα tin. 
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8. Ολοκληρώστε µε ΟΚ. 

 

 

III. ∆ηµιουργία Ψηφιακού Μοντέλου Εδάφους (DEM) 
Το Ψηφιακό Μοντέλο Εδάφους (DEM) αποτελεί µια επιφάνεια (raster) κάθε κελί (cell) της οποίας φέρει µια τιµή 
υψοµέτρου. Τυπικά, χρησιµοποιείται για την απεικόνιση του αναγλύφου του εδάφους. 
 
 

Από το ΤΙΝ είστε σε θέση να δηµιουργήσετε ένα DEM µε την ακόλουθη διαδικασία. 

1. Από τη λίστα εντολών του 3D Analyst επιλέξτε Convert -> TIN to raster. 

 

 

 

 

 

 

 

 

 

 

2. Στο παράθυρο δηµιουργίας του DEM βεβαιωθείτε ότι το εισαγόµενο ΤΙΝ είναι αυτό που µόλις 

δηµιουργήσατε (tin). 

3. Βεβαιωθείτε ακόµη ότι οι τιµές υψοµέτρου θα αντληθούν από το πεδίο Elevation. 

4. Αφήστε στο πεδίο Z factor την προεπιλεγµένη τιµή ως έχει. 

5. Εισάγετε την τιµή 20 για την διάσταση των κελιών του παραγόµενου raster. 



ΕΙΣΑΓΩΓΗ ΣΤΑ ΓΕΩΓΡΑΦΙΚΑ ΣΥΣΤΗΜΑΤΑ ΠΛΗΡΟΦΟΡΙΩΝ 
ΣΥΝΤΟΜΗ ΕΠΙΣΚΟΠΗΣΗ ΣΤΗ ΧΡΗΣΗ ΤΟΥ ESRI ARCGIS 9.X 

ΕΡΓΑΣΤΗΡΙΟ ΓΕΩΦΥΣΙΚΗΣ-∆ΟΡΥΦΟΡΙΚΗΣ ΤΗΛΕΠΙΣΚΟΠΗΣΗΣ & ΑΡΧΑΙΟ-ΠΕΡΙΒΑΛΛΟΝΤΟΣ 
ΙΝΣΤΙΤΟΥΤΟ ΜΕΣΟΓΕΙΑΚΩΝ ΣΠΟΥ∆ΩΝ 
Ι∆ΡΥΜΑ ΤΕΧΝΟΛΟΓΙΑΣ & ΕΡΕΥΝΑΣ (ΙΤΕ) 

36

 

6. Αναζητήστε την τοποθεσία GIS/results και αποθηκεύστε το raster µε το όνοµα DEM. Ολοκληρώστε 

µε ΟΚ. 

 

 

 

 

 

 

 

 

 

 

 

Ταξινοµηµένη απεικόνιση του DEM 

1. Από τον πίνακα περιεχοµένων του ArcMap κάντε διπλό κλικ στο DEM. Εµφανίζεται ένα παράθυρο 

µε επιµέρους καρτέλες που συγκεντρώνουν ανάλογα τις ιδιότητες (Properties) του αρχείου. 

2. Επιλέξτε την ετικέτα Symbology. 

3. Επιλέξτε την εντολή Classified στα αριστερά του παραθύρου. 

4. Κατόπιν, κάντε κλικ στο κουµπί Classify.  

5. Από τη λίστα επιλογών Method επιλέξτε Defined Interval. 

6. Στο πεδίο Interval Size ορίστε την τιµή 20, που αντιστοιχεί στο µεσοδιάστηµα µεταξύ των 

ισοµετρικών καµπύλων που ψηφιοποιήσατε και πατήστε ΟΚ. 

7. Επιλέξτε από την Color Ramp ένα κατάλληλο συνδυασµό χρωµάτων. 

8. ∆ιορθώστε τις τιµές που αναγράφονται ως ετικέτες, Label, σβήνοντας τα δεκαδικά  

9. Εφαρµόστε τις ρυθµίσεις σας πατώντας Apply και ΟΚ. 

10. Στον πίνακα περιεχοµένων κάντε κλικ δύο φορές αργά στη λέξη Value έτσι ώστε να εµφανιστεί ο 

κέρσορας και συµπληρώστε στη θέση της τη φράση “ύψος σε µέτρα” 

11. Τέλος µε δεξί κλικ πάνω στο dem από τον πίνακα περιεχοµένων επιλέξτε την εντολή Save As Layer 

File για να σώσετε το συγκεκριµένο συµβολισµό για το αρχείο αυτό. 
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IV. ∆ηµιουργία σκιασµένου αναγλύφου εδάφους (hillshade) 
Το σκιασµένο ανάγλυφο εδάφους (hillshade) είναι µια επιφάνεια (raster) που λαµβάνει υπόψη τις κατά τόπους γωνίες 
φωτεινότητας και σκιές του τοπίου. Με αυτή την επιφάνεια αποκοµίζετε την υποθετική φωτεινότητα του εδάφους 
προσδιορίζοντας τιµές φωτεινότητας για κάθε κελί της επιφάνειας. Το σύστηµα ορίζει τη θέση µιας υποθετικής πηγής 
φωτός και υπολογίζει τις τιµές φωτεινότητας για κάθε κελί σε σχέση µε τα γειτονικά κελιά. Το αποτέλεσµα µπορεί να 
εµπλουτίσει σηµαντικά την απεικόνιση µιας επιφάνειας προς ανάλυση ή γραφική παρουσίαση. Η διαδικασία που 
ακολουθεί το σύστηµα γενικά έχει ως εξής:  
Η σκιά και το φως αποδίδονται µε γκρι αποχρώσεις που αντιστοιχούν σε ακέραιες τιµές από 0 έως 255, αυξάνοντας 
από µαύρο έως λευκό. 
Η γωνιακή κατεύθυνση του ήλιου (azimuth) υπολογίζεται ξεκινώντας από τον Bορρά και µε διεύθυνση των δεικτών 
του ρολογιού. Αποδίδεται µε µοίρες από 0 έως 360. Π.χ. το αζιµούθιο των 90 µοιρών βρίσκεται στην ανατολή. Η 
προεπιλεγµένη από το σύστηµα τιµή είναι 315 (Β∆). 
Η γωνία όπου βρίσκεται η πηγή φωτός πάνω από τον ορίζοντα (altitude), αποδίδεται µε µοίρες από 0 (στον ορίζοντα) 
έως 90. Η προεπιλεγµένη τιµή είναι 45.    

 
 

Από το DEM έχετε τη δυνατότητα να παράγετε ένα σκιασµένο ανάγλυφο του εδάφους εκτελώντας την 

ακόλουθη σειρά εργασιών.  
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1. Από την µπάρα εργαλείων του Spatial Analyst ακολουθήστε την διαδροµή Spatial Analyst -> 

Surface Analysis -> Hillshade. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Στο παράθυρο που θα εµφανιστεί βεβαιωθείτε ότι το εισαγόµενο raster αρχείο είναι το DEM που 

δηµιουργήσατε. 

3. Αφήστε τις τιµές αζιµουθίου (Azimuth) και υψοµέτρου (Altitude) ως έχουν. 

4. Επίσης, αφήστε το κουτάκι επιλογής δίπλα στην εντολή Model shadows κενό. 

5. Αφήστε τις τιµές του παράγοντα Ζ 1 και της διάστασης του κελιού 20 για το παραγόµενο raster.  
6. Πλοηγηθείτε στο c:\seminars\GIS\results, αποθηκεύστε το αρχείο µε το όνοµα hillshade  

7. και πατήστε ΟΚ 
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Βελτιωµένη γραφική παρουσίαση του DEM µε χρήση του Hillshade 

Μπορείτε να χρησιµοποιήσετε το hillshade, αν το επιθυµείτε, για να εµπλουτίσετε την γραφική παρουσίαση 

του DEM σας.  

1. Στον πίνακα περιεχοµένων του ArcMap σύρετε και τοποθετήστε το DEM πάνω από το Ηillshade.  

2. Από το µενού View προσθέστε την µπάρα εργαλείων Effects. 

 

 

 

3. Επιλέξτε σε αυτήν το Layer DEM.  

4. Κάνετε κλικ στο κουµπί Adjust Transparency      και επιλέξτε ένα ποσοστό 30%. 

5. Επιθεωρήστε το αποτέλεσµα και αλλάξτε το ποσοστό ανάλογα µε την επιθυµητή παρουσίαση.  

 

 

V. Μοντελοποίηση των γωνιών κλίσης του αναγλύφου εδάφους (Slope). 
Συχνά µας ενδιαφέρει να γνωρίζουµε την διαφοροποίηση της κλίσης του εδάφους προκειµένου να εντοπίσουµε τις 
περιοχές µε µεγαλύτερο κίνδυνο εδαφικής κατακρήµνισης. Τέτοιο µοντέλο της κλίσης του εδάφους µπορούµε να 
αντλήσουµε από το ψηφιακό µοντέλο εδάφους (DEM). Κάθε κελί της παραγόµενης επιφάνειας φέρει µια τιµή κλίσης. 
Όσο χαµηλότερες είναι οι τιµές κλίσης τόσο πιο οµαλό και πεδινό φαίνεται να είναι το ανάγλυφο του εδάφους. 
Αντίθετα, όσο υψηλότερες είναι οι τιµές κλίσης, τόσο πιο απότοµο είναι αυτό. Το σύστηµα µπορεί να υπολογίσει και 
να αποδώσει τις τιµές κλίσης σε µοίρες ή ποσοστό. Π.χ. µία τιµή κλίσης 45 µοιρών αποδοσµένη σε ποσοστό είναι ίση 
µε 100%. Πρέπει να σηµειωθεί ότι όσο η τιµή κλίσης πλησιάζει την κατακόρυφο (90 µοίρες) το ποσοστό κλίσης 
πλησιάζει το άπειρο. 

 
Θα αντλήσετε ένα µοντέλο της κλίσης του εδάφους από το DEM µε τον εξής τρόπο. 

1. Ακολουθήστε την διαδροµή Spatial Analyst -> Surface Analysis -> Slope. 

2. Βεβαιωθείτε ότι το εισαγόµενο ανάγλυφο εδάφους (Input surface) είναι το DEM. 

3. Επιλέξτε µοίρες (degrees) για τη µονάδα µέτρησης της κλίσης. 

4. Αφήστε την τιµή του παράγοντα Ζ και την τιµή διάστασης των κελιών της παραγόµενης επιφάνειας 

(Output cell size) ως έχουν. 

5. Αποθηκεύστε το νέο αρχείο µε το όνοµα slope στον φάκελο results και πατήστε ΟΚ 
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VI. Μοντελοποίηση του προσανατολισµού του αναγλύφου εδάφους (Aspect). 
Σε περιπτώσεις, µας ενδιαφέρει ο κατά τόπους προσανατολισµός της επιφάνειας του εδάφους. Π.χ. επιθυµούµε να 
εντοπίσουµε τις περιοχές µε κατάλληλο προσανατολισµό για ορισµένες καλλιέργειες, ή τις επίπεδες περιοχές για την 
ίδρυση έργων ανάπτυξης. Το σύστηµα χρησιµοποιεί το DEM και µοντελοποιεί την διεύθυνση της κλίσης ή αλλιώς την 
διεύθυνση της πυξίδας που αντιστοιχεί σε κάθε πλευρά ενός λόφου. Οι τιµές αποδίδονται µε µοίρες ακολουθώντας τη 
διεύθυνση των δεικτών του ρολογιού από 0, στον Βορρά, έως 360, πάλι στον Βορρά µετά από διαγραφή ολόκληρου 
κύκλου. Η τιµή κάθε κελιού σε µια επιφάνεια προσανατολισµού δηλώνει τη διεύθυνση της κλίσης του κελιού. Κατά 
συνέπεια, επίπεδες κλίσεις δεν φέρουν διεύθυνση και τους αποδίδεται η τιµή -1. 

 
 
 

Για να αντλήσετε τον κατά τόπους προσανατολισµό της επιφάνειας του εδάφους θα χρησιµοποιήσετε το 

DEM εκτελώντας τα ακόλουθα βήµατα: 

 

1. Ακολουθήστε την διαδροµή Spatial Analyst -> Surface Analysis -> Aspect. 

2. Βεβαιωθείτε ότι το εισαγόµενο µοντέλο εδάφους είναι το DEM. 

3. Αφήστε την προεπιλεγµένη τιµή διάστασης των κελιών του παραγόµενου αρχείου ως έχει. 

4. Επιθεωρήστε την τοποθεσία αποθήκευσης , δώστε το όνοµα aspect στο αρχείο και ολοκληρώστε µε 

ΟΚ. 
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Σύνθετες χωρικές αναλύσεις 
 
Σ΄αυτό το σηµείο θα µελετήσουµε τα εδάφη της περιοχής του Λασιθίου και θα εξετάσουµε ποια από αυτά 

θα µπορούσαν να θεωρηθούν καλλιεργήσιµη γη. Για το λόγο αυτό θα συνδυάσετε κάποια χαρακτηριστικά 

από δύο διαφορετικές θεµατικές ενότητες, τη γεωλογία και τη χρήση γης και στη συνέχεια θα 

διασταυρώσετε τα αποτελέσµατα µε εκτάσεις χαµηλής κλίσης.  

 

∆ιατύπωση ερωτηµάτων 

 

1. Ανοίγετε ένα νέο project στο ArcMap και προσθέτετε τις θεµατικές ενότητες geology και landuse 

από τον φάκελο Spatial_AnalysisII 

2. Από το κυρίως µενού επιλέξτε Selection > Select By Attributes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Επιλέγετε ως Layer: landuse και ως Method: Create a new selection και συνεχίζετε τη διατύπωση 

του ερωτήµατος συµπληρώνοντας κάτω από το 
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Use the same Coordinate System as this layer's source data. 

 

SELECT * FROM landuse WHERE: 

 

"PHYSIOGR1" = 'LOWER SLOPES' OR "PHYSIOGR1" = 'OPEN VALLEYS' OR 

"SOIL_DEPTH" = 'DEEP' OR "SOIL_DEPTH" = 'DEEP AND SHALLOW' OR 

"ARTIF_VEG" = 'AGRICULTURE'  

είτε πληκτρολογώντας είτε επιλέγοντας τις συγκεκριµένες τιµές από τα αντίστοιχα πεδία 

4. Tρέχετε το ερώτηµα πατώντας Apply και κλείνετε το παράθυρο µε Close 

5. Στον πίνακα περιεχοµένων του ArcMap µε δεξί κλικ πάνω στο landuse επιλέγετε Data > Export 

Data  

 

 

 

 

 

 

 

 

 

6. Αποδέχεστε την εξαγωγή µόνο των επιλεγµένων εγγραφών σε νέα θεµατική ενότητα  

Export: Selected features και τη χρήση του ίδιου συστήµατος συντεταγµένων µε το αρχικό αρχείο   

 

7.  Προσδιορίζετε το πού και µε ποιο όνοµα θα σώσετε το νέο αρχείο 

c:\seminars\GIS\results\lasithi_land πατάτε OK και YES στην ερώτηση του συστήµατος αν θέλετε 

να εµφανιστεί στην επιφάνεια εργασίας σας. 

8. Από το κυρίως µενού πηγαίνετε στο Selection > Clear Selected Feature 

9. Επαναλαµβάνοντας τη διαδικασία που ακολουθήσατε για τη χρήση γης, θα επιλέξετε τώρα από τη 

γεωλογία κάποια άλλα χαρακτηριστικά. Πηγαίνετε πάλι στο Select By Attributes και διατυπώνετε 

ένα νέο ερώτηµα 

10. Από το κυρίως µενού επιλέγετε Selection > Select By Attributes 

11. Επιλέγετε ως Layer: geology και ως Method: Create a new selection και συνεχίζετε τη διατύπωση 

του ερωτήµατος συµπληρώνοντας κάτω από το 

 

SELECT * FROM geology WHERE: 

"GENERAL" = 'Alluvial' OR "GENERAL" = 'Flysch' OR "GENERAL" = 'Deposits'  

 

12. Ακολουθείτε τα βήµατα 3-5 κάνοντας κλικ αυτή τη φορά στο geology και σώζοντας το νέο αρχείο 

ως lasithi_geo 
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 Ενοποίηση (Union)   

     

1. Στο παράθυρο του ArcToolbox ανοίγετε την εργαλειοθήκη Analysis Tools, εµφανίζετε τις εντολές 

που βρίσκονται κάτω από τον τίτλο Overlay και επιλέγετε την εντολή Union 

2. Στο παράθυρο διαλόγου επιλέγετε ως Input Features  τα shapefiles lasithi_land και lasithi_geo τις 

εγγραφές των οποίων θα ενοποιήσετε  

3. Προσδιορίζετε ποιο θα είναι το Output Feature Class c:\seminars\landgeo_Union αποδέχεστε τις 

υπόλοιπες παραµέτρους και πατάτε ΟΚ 

 

Το νέο αρχείο έχει προστεθεί στην εργασία σας 

 

 

Προαιρετικές Παράµετροι 

Η παράµετρος Join Attributes καθορίζει ποια χαρακτηριστικά (πεδία) από τις ενότητες που έχουν εισαχθεί 

στο πρόγραµµα (Input Features) θα µεταφερθούν στην ενότητα που θα δηµιουργηθεί από αυτό (Output 

Feature Class). 

• Αν επιλέξουµε ALL, όλα τα πεδία που υπάρχουν στον πίνακα χαρακτηριστικών των Input Features 

θα µεταφερθούν και στο Output Feature Class. 

• Αν επιλέξουµε NO_FID θα µεταφερθούν όλα τα πεδία εκτός του FID (δηλαδή του µοναδικού 

αριθµού που αντιστοιχεί σε κάθε εγγραφή µιας θεµατικής ενότητας) 

• Τέλος αν επιλέξουµε ONLY_FID θα µεταφερθεί µόνο το πεδίο του FID 

 

 

Η παράµετρος Cluster Tolerance καθορίζει την απόσταση µέσα στην οποία γειτονικά σύνορα και σηµεία 

στα πλαίσια της ίδιας ενότητας ταυτίζονται ή συµπίπτουν. Για την αποφυγή σφάλµατος η απόσταση αυτή θα 

πρέπει να είναι όσο το δυνατόν µικρότερη ανάλογα µε την ακρίβεια των δεδοµένων. Ως προεπιλογή το 

πρόγραµµα υπολογίζει τη µικρότερη δυνατή απόσταση σύµφωνα µε το γεωδαιτικό σύστηµα αναφοράς.  

 

 

Ταξινόµηση  

Σ΄αυτό το στάδιο θα προσθέσετε στην εργασία σας το αρχείο που περιλαµβάνει τις τιµές κλίσης του 

εδάφους και θα διαχωρίσετε τις περιοχές εκείνες που έχουν χαµηλή κλίση (0 έως 10 µοίρες) , έτσι ώστε να 

αποµονώσετε την καλλιεργήσιµη γη. Για το λόγο αυτό θα κάνετε µία ταξινόµηση της κλίσης. 

 

Από τον πίνακα περιεχοµένων αποεπιλέξτε µε δεξί κλικ το αρχείο landgeo_Union προκειµένου να 

εµποδίσετε προσωρινά την προβολή του στο παράθυρο επισκόπησης. 
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Εισάγετε στην εργασία σας το 

αρχείο slope_lasihi από τον φάκελο 

Spatial_AnalysisII 

1. Στην µπάρα εργαλείων 

Spatial Analyst επιλέγετε 

Reclassify και στη συνέχεια 

Classify.  

2. Στο Classification Method 

διαλέγετε το Natural Breaks 

ορίζετε δύο τάξεις classes 2, 

αλλάζετε κάτω από το 

Break Values την πρώτη 

τιµή σε 10 και τη δεύτερη 

σε 75 και πατάτε OK 

3. τσεκάρετε την επιλoγή 

Change missing values to NoData , σώζετε το νέο αρχείο σαν rclass_slope και ξανά OK 

 

 

Στη συνέχεια θα µετατρέψετε το rclass_slope από αρχείο εικονοστοιχείων (raster) σε αρχείο γραµµικών 

στοιχείων (vector)   

 

1. Πηγαίνετε Spatial Analyst > Convert > Raster to Features  

2. ∆έχεστε τις προεπιλογές και δίνετε το όνοµα rclass_slope2 στο νέο vector αρχείο 

3. Με τις εντολές Select By Attributes και Export Data που είδαµε παραπάνω αποσπάτε τα 

πολύγωνα εκείνα που έχουν τιµή 1 και σώζετε το νέο αρχείο ως low _slope 

 

 

∆ιατοµή (Intersect) 

 

Για να προχωρήσετε τώρα στη διατοµή των ενοποιηµένων χαρακτηριστικών της γεωλογίας και της χρήσης 

γης µε τη χαµηλή κλίση θα εφαρµόσετε την εντολή Intersect.  

 
Σηµείωση 

Η ενοποίηση αφορά µονό θεµατικές ενότητες µε τη µορφή πολυγώνου. Η διατοµή αφορά θεµατικές ενότητες όλων των 

σχηµατικών τύπων. 
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1. Στο παράθυρο του ArcToolbox ανοίγετε την εργαλειοθήκη Analysis Tools, εµφανίζετε τις εντολές 

που βρίσκονται κάτω από τον τίτλο Overlay και επιλέγετε την εντολή Intersect 

2. Στο παράθυρο διαλόγου επιλέγετε ως Input Features τα shapefile τα οποία θέλετε να 

διασταυρώσετε landgeo_Union και low_slope 

3. Προσδιορίζετε ποιο θα είναι το Output Feature Class c: \seminars\agriculture και πατάτε ΟΚ 

Στην επιφάνεια εργασίας σας έχει προστεθεί µια θεµατική ενότητα πολυγώνων που περικλείει περιοχές οι 

οποίες τηρούν όλες τις προϋποθέσεις που ορίσατε και συνεπώς µπορούν να χαρακτηριστούν ως 

καλλιεργήσιµες. 
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Παρουσίαση Αποτελεσµάτων 
 

Με αυτήν την άσκηση θα συνθέσετε έναν χάρτη µε τους υδάτινους πόρους του Νοµού Λασιθίου. Για να το 

επιτύχετε θα προβάλλετε διαφορετικά θεµατικά επίπεδα και θα προσθέσετε στον χάρτη υπόµνηµα, κλίµακα, 

το σύµβολο του Βορρά και τον απαραίτητο τίτλο. 

 

Σύνθεση Χάρτη (Layout) 

1. Προσθέστε στην επιφάνεια εργασίας του ArcMap µε την ακόλουθη σειρά τα αρχεία Hillshade, 

DEM, Springs και Streams που βρίσκονται αποθηκευµένα στην τοποθεσία C/seminars/GIS/Layout. 

2. Επιλέξτε για καθένα από τα αρχεία DEM, Springs και Streams τον κατάλληλο χρωµατικό και 

σχεδιαστικό συµβολισµό και χρησιµοποιήστε το Hillshade για να εµπλουτίσετε την γραφική 

παρουσίαση του DEM (πρβλ. Βελτιωµένη γραφική παρουσίαση του DEM µε χρήση του Hillshade, 

σελ.40 ). 

3. Επιλέξτε την εµφάνιση όλων των δεδοµένων σε πλήρη έκταση κάνοντας κλικ στο εικονίδιο Full 

extent. 

4. Από το κυρίως µενού επιλέξτε View > Layout View.  

 

Προσθήκη Υποµνήµατος (Legend) 

 

1. Από το κυρίως µενού επιλέξτε Insert > Legend. Στο παράθυρο που εµφανίζεται το σύστηµα έχει 

εισάγει σε δύο στήλες τα θεµατικά επίπεδα που έχετε χρησιµοποιήσει για την σύνθεση του χάρτη. Η 

στήλη Map Layers απαριθµεί τα θεµατικά επίπεδα που συνθέτουν τον χάρτη. Η στήλη Legend Items 

απαριθµεί τα θεµατικά επίπεδα που θα εµφανίζονται στο υπόµνηµα του χάρτη. Μεταξύ των στηλών 

υπάρχουν µονά βέλη που µεταφέρουν στην ανάλογη στήλη το θεµατικό επίπεδο που έχετε επιλέξει, και 

διπλά βέλη που µεταφέρουν στην ανάλογη στήλη ταυτόχρονα όλα τα θεµατικά επίπεδα. 

2. Από την στήλη Legend Items επιλέξτε το Hillshade και κάντε κλικ στο µονό βέλος µε κατεύθυνση προς 

τα αριστερά προκειµένου να το αφαιρέσετε από το υπόµνηµα. 

3. Επιλέξτε Next και προχωρήστε στο επόµενο παράθυρο. 

4. Στο πλαίσιο κειµένου πληκτρολογήστε τον τίτλο του υποµνήµατος (Υπόµνηµα) και κατόπιν ρυθµίστε 

τις υπόλοιπες ιδιότητες του τίτλου, όπως το χρώµα (Color), το µέγεθος (Size), την γραµµατοσειρά 

(Font), κτλ. Προχωρήστε στο επόµενο παράθυρο επιλέγοντας Next. 

5. Με αυτό το παράθυρο έχετε τη δυνατότητα διαµόρφωσης του πλαισίου που θα περιβάλλει το υπόµνηµα, 

τον τύπο της κορνίζας (Border), το χρώµα του φόντου (Background) και το χρώµα της φωτοσκίασης 

(Drop Shadow). Στη συνέχεια ορίζετε το ποσοστό στρογγυλοποίησης του πλαισίου (Rounding) και τη 

θέση της φωτοσκίασης, αναφορικά µε το κυρίως πλαίσιο προσδιορίζοντας την τιµή απόστασης των δύο 

σε pixels (Gap). Συνεχίστε επιλέγοντας Next.  
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6. Σε αυτό το στάδιο, το πρόγραµµα δίνει τη δυνατότητα αλλαγής του σχήµατος και του µεγέθους των 

συµβολισµών για κάθε ένα θεµατικό επίπεδο. ∆εχτείτε τις προεπιλογές και προχωρήστε µε Next στο 

επόµενο.  

7. Τέλος, ρυθµίστε τις αποστάσεις µεταξύ όλων των στοιχείων του υποµνήµατος. Για να ολοκληρώσετε τη 

διαδικασία επιλέξτε Finish. 

8. Από το κυρίως µενού επιλέξτε διαδοχικά View > Toolbars > Draw και εµφανίστε την σχετική µπάρα 

εργαλείων. 

 

 

9. Επιλέξτε το εργαλείο Select Elements tool    και κάντε κλικ στο υπόµνηµα, έτσι ώστε να εµφανιστούν 

µπλε τετραγωνάκια στις τέσσερις άκρες του. Τοποθετώντας τον κέρσορα πάνω σε αυτά παρατηρείτε ότι 

αυτός µεταβάλλεται σε βέλος διπλής κατεύθυνσης και ενεργοποιείται µε αυτόν τον τρόπο η διαδικασία 

µεγέθυνσης ή σµίκρυνσης του υποµνήµατος. Κάντε κλικ και σύρετε το βέλος διπλής κατεύθυνσης 

ανάλογα για να ορίσετε το επιθυµητό µέγεθος του υποµνήµατος. 

10. Στη συνέχεια, τοποθετώντας τον κέρσορα στο κέντρο του υποµνήµατος αυτός αλλάζει σε σταυρό και 

ενεργοποιείται έτσι η διαδικασία µετακίνησης του υποµνήµατος. Σύρετε τον σταυρό και τοποθετήστε το 

υπόµνηµα στην κάτω δεξιά γωνία του χάρτη. 

 

Προσθήκη Κλίµακας (Scale) 

 

1. Από το 

κυρίως µενού 

επιλέξτε 

Insert > 

Scale Bar.  

2. Επιλέξτε από 

το παράθυρο 

προεπισκόπη

σης τον τύπο 

κλίµακας που 

επιθυµείτε 

και κατόπιν 

επιλέξτε το 

κουµπί 

Properties. 
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3. Επιλέξτε την καρτέλα Scale and Units. 

4. Θα ρυθµίσετε την απόσταση που θα 

αντιπροσωπεύει στον χάρτη η κλίµακα 

µε τις υποδιαιρέσεις της. Στο Number 

of subdivisions πληκτρολογήστε τον 

αριθµό 2.  

5. Αποεπιλέξτε την παράµετρο Show one 

division before zero. 

6. Στη συνέχεια, κάτω από το When 

resizing επιλέξτε το Adjust number of 

divisions προκειµένου να ελέγχετε τον 

αριθµό των υποδιαιρέσεων της 

κλίµακας. Μ’ αυτόν τον τρόπο µπορείτε 

να προσθέτετε ή να αφαιρείτε 

υποδιαιρέσεις καθώς µεγεθύνετε ή 

σµικρύνετε την κλίµακα, σύροντας τα 

τετραγωνάκια που εµφανίζονται στις 

άκρες της, όταν την έχετε επιλέξει στον 

χάρτη. 

7. Επανέλθετε στην αρχή των ρυθµίσεων και στο Division value δώστε τον αριθµό 1. 

8. Ορίστε ως µονάδα µέτρησης το χιλιόµετρο επιλέγοντας kilometers κάτω από το Division Units.  

9. Αποδεχτείτε τις υπόλοιπες προεπιλογές και ολοκληρώστε µε ΟΚ. 

10. Μετακινήστε την κλίµακα στην κάτω αριστερή γωνία του χάρτη σας. 

 
Σηµείωση 
Αν θέλετε να εστιάσετε σε κάποιο σηµείο του σελιδοποιηµένου χάρτη ή να τον εµφανίσετε σε πλήρη έκταση 
χρησιµοποιείτε τα εργαλεία που βρίσκονται στην µπάρα εργαλείων Layout. Πιο αναλυτικά µε τα παρακάτω εργαλεία : 
 

 

 
1. Μεγεθύνετε πάνω σε κάποιο σηµείο ή περιοχή. 
2. Σµικρύνετε από ένα σηµείο ή περιοχή. 
3. Μετακινείστε στο χάρτη σύροντας το ποντίκι. 
4. Μεγεθύνετε πάνω στο κέντρο του χάρτη. 
5. Σµικρύνετε από το κέντρο του χάρτη. 
6. Εστιάζετε σε ολόκληρη την έκταση του χάρτη. 
7. Εστιάζετε στο 100% του χάρτη. 
8. Επανέρχεστε στην προηγούµενη εστίαση από αυτή που βρισκόσαστε. 
9. Επανέρχεστε στην επόµενη εστίαση από αυτή που βρισκόσαστε. 
10.Ορίζετε σε ποιο ποσοστό του χάρτη θέλετε να εστιάσετε. 
11.Προβάλλετε το σελιδοποιηµένο χάρτη σε πρόχειρη µορφή. 
12.Επικεντρώνετε το πλαίσιο δεδοµένων. 
13.Αλλάζετε τύπο σελιδοποίησης. 

1 2 3 4 5 6 7 8 9 10 11 12 13
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Προσθήκη Σύµβολου Βορρά (North Arrow) 

 

11. Για να προσθέσετε το σύµβολο του Βορρά στον χάρτη σας, επιλέξτε από το κυρίως µενού Insert > 

North Arrow.  

12. Επιλέξτε τον τύπο Βορρά που επιθυµείτε και ολοκληρώστε µε ΟΚ . 

13. Μετακινήστε το σύµβολο του βορρά στην πάνω δεξιά γωνία του χάρτη. 

 

Προσθήκη Τίτλου Χάρτη (Title) 

 

14. Επιλέξτε από το κυρίως µενού Insert > Title για να προσθέσετε στον χάρτη το πλαίσιο κειµένου µέσα 

στο οποίο θα πληκτρολογήσετε τον τίτλο του χάρτη. 

15. Πληκτρολογήστε τον επιθυµητό τίτλο. 

16. Από την µπάρα εργαλείων Draw αλλάξτε την γραµµατοσειρά και το µέγεθος του κείµενου όπως 

επιθυµείτε. 

 

Επιθεωρήστε το αποτέλεσµα και πειραµατιστείτε µε τις επιλογές του προγράµµατος προκειµένου να 

βελτιώσετε την εικόνα του χάρτη. 

 

Εκτύπωση Χάρτη 

 

1. Από το κυρίως µενού επιλέξτε File > Export Map προκειµένου να εξάγετε τον σελιδοποιηµένο χάρτη 

µε την µορφή εικόνας. 

2. Στο παράθυρο που θα εµφανιστεί περιηγηθείτε στον φάκελο results. 

3. Στο File Name επιλέξτε και πληκτρολογήστε ένα όνοµα για να αποθηκεύσετε µε αυτό τον χάρτη σας.  

4. Επιλέξτε από το Save as Type τον τύπο αρχείου µε τον οποίο επιθυµείτε να αποθηκεύσετε τον χάρτη 

σας, π.χ. TIFF, JPEG. 

5. Από το Resolution επιλέξτε την επιθυµητή ανάλυση της εικόνας, π.χ. 300. 

6. Αποθηκεύστε την εικόνα επιλέγοντας Save. 

Έχετε στην διάθεσή σας ένα αρχείο που µπορείτε να το µεταχειριστείτε όπως οποιαδήποτε εικόνα. 
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Τεκµηρίωση – ∆ιαχείριση – Αξιοποίηση Χωρικών ∆εδοµένων 

∆ηµιουργία Μεταδεδοµένων (Metadata) 
 

Για την αποτελεσµατική διαχείριση και αξιοποίηση των ψηφιακών χωρικών δεδοµένων το σύστηµα 

ArcGIS εµπεριέχει µια εφαρµογή XML που σας δίνει τη δυνατότητα να τεκµηριώσετε άρτια και µε 

συνέπεια τις πηγές πληροφοριών και τα παραγόµενα δεδοµένα σας. Με αυτόν τον τρόπο δηµιουργείτε 

µεταδεδοµένα που καθιστούν αξιοποιήσιµη την εργασία σας τόσο από εσάς τους ίδιους και την 

υπηρεσία ή τον οργανισµό για τους οποίους εργάζεστε, όσο και από τρίτους φορείς µε κοινά 

ενδιαφέροντα και ερευνητικά προγράµµατα. 

Τα µεταδεδοµένα περιγράφουν ένα Σύστηµα Γεωγραφικών Πληροφοριών όπως περιγράφει µια κάρτα 

καταλόγου βιβλιοθήκης ένα βιβλίο. Οι πληροφορίες που καταγράφονται για κάθε στοιχείο του 

συστήµατος ενηµερώνουν για την ποιότητα, την ακρίβεια, την επικαιρότητα, τα δικαιώµατα του 

δηµιουργού κι άλλες χρήσιµες πληροφορίες, αναγκαίες για την µελλοντική ανεύρεση και αξιοποίηση 

του υλικού σας.  

Η Metadata εφαρµογή του ArcCatalog διακρίνεται σε ιδιότητες (properties) και τεκµηρίωση 

(documentation). Στις ιδιότητες συγκαταλέγονται πληροφορίες όπως π.χ. η γεωγραφική έκταση ενός 

αρχείου ή το χαρτογραφικό σύστηµα συντεταγµένων που έχει χρησιµοποιηθεί για να προβληθεί αυτό. Η 

τεκµηρίωση µπορεί να αφορά την περιγραφή του περιεχοµένου του αρχείου ή το νόµιµο δικαιούχο. 

Κάποιες από αυτές τις πληροφορίες είναι δυνατόν να ενηµερωθούν αυτόµατα από το ArcCatalog 

παράλληλα µε τη δηµιουργία του κάθε αρχείου, µετά από ανάλογη ρύθµιση του συστήµατος. Τα 

µεταδεδοµένα που δηµιουργούνται αυτόµατα δεν είναι αρκετά για µια συνεπή τεκµηρίωση του 

συστήµατος. Είναι επιθυµητό να συµπληρώνονται το δυνατόν περισσότερες πληροφορίες ή έστω όσες 

διαθέτετε για κάθε τύπο δεδοµένων που έχετε στην κατοχή σας.  

Ο Κατάλογος έχει τη δυνατότητα να καταχωρεί µεταδεδοµένα ακολουθώντας δύο διαφορετικά πρότυπα 

τεκµηρίωσης (standards), το FGDC’s Content Standard for Digital Geospatial Metadata για σχετικά 

λεπτοµερή και εκτενή τεκµηρίωση, και το ISO standard 19115 Geographic Information-Metadata που 

δηµιουργήθηκε για να εξυπηρετήσει διεθνείς ανάγκες, και ικανοποιεί τις απαιτήσεις όλων των 

υπαρχόντων προτύπων. Επιτρέπει γενική, αλλά και πιο λεπτοµερή τεκµηρίωση και περιλαµβάνει 

λιγότερα υποχρεωτικά προς συµπλήρωση πεδία πληροφοριών. Πρότυπα τεκµηρίωσης ωστόσο υπάρχουν 

πολλά και το ArcGIS καθιστά δυνατή την εισαγωγή στο σύστηµα και χρήση κάποιου προτύπου που 

εξυπηρετεί τον οργανισµό σας και τη µελέτη σας.  

Η δηµιουργία µεταδεδοµένων αποτελεί µια χρονοβόρα και κατά συνέπεια πολυέξοδη διαδικασία, 

ωστόσο η άρτια τεκµηρίωση του υλικού σας έχει µέγιστη σηµασία για την µελλοντική αξιοποίηση των 

δεδοµένων και των κόπων σας. Μεταδεδοµένα µπορούν να συνοδεύουν κάθε τύπο αρχείου, φακέλου, ή 

συνόλου δεδοµένων. ∆ηµιουργούνται ξεχωριστά για καθένα από αυτά τα στοιχεία και αντιγράφονται 

και µετακινούνται παράλληλα µε το αρχείο, όταν το διαχειρίζεστε µέσα από τον Κατάλογο.  
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Με τον ακόλουθο τρόπο θα επιτελέσετε κάποιες αρχικές ρυθµίσεις της εφαρµογής metadata και στη 

συνέχεια θα προσθέσετε µεταδεδοµένα ενδεικτικά για ένα από τα αρχεία που δηµιουργήσατε κατά την 

ανάλυση. 

 

1. Ανoίξτε το ArcCatalog. 

2. Από το µενού Tools επιλέξτε Options.  

3. Επιλέξτε την καρτέλα Metadata.  

4. Επιλέξτε ή αποεπιλέξτε τα κουτάκια επιλογών ανάλογα µε το αν επιθυµείτε να δηµιουργούνται 

και να ενηµερώνονται ορισµένα µεταδεδοµένα αυτόµατα από τον Κατάλογο. 

5. Επιλέξτε από το βέλος της λίστας επιλογών το πρότυπο τεκµηρίωσης που επιθυµείτε να 

χρησιµοποιήσετε για την δηµιουργία και παρουσίαση µεταδεδοµένων. 

6. Ολοκληρώστε τις ρυθµίσεις σας µε ΟΚ. 

7. Επιλέξτε στον πίνακα περιεχοµένων του Καταλόγου το αρχείο στο οποίο θέλετε να προσθέσετε 

µεταδεδοµένα. 

8. Στο παράθυρο επισκόπησης του Καταλόγου επιλέξτε την καρτέλα Metadata. 

9. Από την µπάρα εργαλείων Metadata επιλέξτε το κουµπί Edit Metadata.  

10. Εισάγετε τις ανάλογες πληροφορίες στα υποχρεωτικά πεδία του προτύπου, καθώς και όσες 

άλλες διαθέτετε για το συγκεκριµένο αρχείο. 

11. Όταν ολοκληρώσετε, επιλέξτε το κουµπί Save για να αποθηκεύσετε τα µεταδεδοµένα σας. 
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